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Quick Start 
 

Start the Graphical Label Designer 
 

In Windows, click Start, All Programs, T.L. Ashford and Associates, Barcode400 and then 
click Barcode400 Graphical Interface. Or, click the Barcode400 icon on the Windows 
desktop. The Server Signon screen will appear. 
 
 

Server SignOn 
 

To design and print bar code labels, a user must Sign On to the Barcode400 Designer. 
First-time users will need to create a server connection. See Add Server 

 

 
 

At the SignOn Screen, enter the user’s IBMi Userid and Password. 
 
 

Click SignOn. The Barcode400 Work with Label Formats screen will appear.  
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Creating a Label Format 
 
 

This Quick Start guide will illustrate the steps necessary to create the label shown below 
using the Graphical Label Design software. 
 

 
 

This sample label will use five types of objects: alpha fields, barcodes, graphics (logos), 
rectangles and lines. All information on the label will be static data. 
 
 

There are eight steps needed to create and print this sample label. 
 

Step 1. Create a New Label Format 

Step 2. Place the words Birthday Cake on the Label. 

Step 3. Place a UPC-A barcode on the Label. 

Step 4. Place the Cake graphic on the label. 

Step 5. Place the Rectangle on the label. 

Step 6. Place the Line on the label. 

Step 7. Save the Label 

Step 8. Print a Test Label 

 
 
 
 

Turn to the following page to begin 
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Step 1. - Create a New Label Format 
 

The Work with Label Formats window is displayed after logging on. 
 

Click     - A new blank Label Design will display. 
 

 
 
 

For this sample, in the Properties Dialogbox on the right, change the following fields: 
 
 

Label Format 
 

Name - Change to DEMO 
Description - Change to Sample Label 
 

Label Size  
 

Width – Change to 4 
Height – Change to 3 
(Values are in inches) 
 

 

Target Printer 
 

Manufacturer – Zebra 
Model – 140XiII, XiIII, XiIV 
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Step 2. – Add Text 
 

This step will place the words ‘Birthday Cake’ and a ‘$6.99’ price on the new label. 
 

 
 
 

Click    to create a new Text Field. The Text Field Properties window will display. 
 

 
 
Type Birthday Cake in the Data Field. 
 

Select the ‘F909 -36 pt. CG Triumvirate’ font from the drop-down list.  
 

Click OK.  
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The cursor will display as +ABC indicating a Text Field.  
 

 
 
 

Position the cursor to the desired location.  
 

Click to place. 
 
 
 

‘Birthday Cake’ appears on the label in the 36pt. font style. 
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Use the same method to place the text “$6.99” on the label. 
 

Click the Add Text Object  button again. 
 

Type $6.99 in the Data Field.  
 

Select the ‘F909 - 36 pt. CG Triumvirate’ font. 
 

Click OK 
 

Position the Cursor to the desired location.  
 

Click to place. 
 
 
 
 

 
Both text objects now appear on the label in the desired positions. 
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Step 3. – Add a Barcode 
 

This step will place the UPC-A retail barcode on the label 
 

 
 
 

Click   to create a new Barcode Object. 
 
 
 

A new Barcode Properties window will display. 
 

 
 
 

Type 01234567890 in the Data field. In this case, UPC-A requires 11 digits. 
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From the Symbology List, select UPC-A.  
 

Click OK.  
 
 
The cursor will display as a barcode, indicating a barcode object. 
 

 
 

Position the cursor to the desired location.  
 

Click to place. 
 
 
 

The UPC-A barcode now appears on the label. 
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Step 4. – Add a Graphic 
 

This step will place the Cake graphic on the label. 
 

 
 
 

Click  to add a graphic. The Add Graphic options will display. 
 

 
 
 
 

Select Static Graphic. The Graphic Directory will display. 
 

 
 

 
Select Cake from the Graphic directory.  
 
 

Click Open.  
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The graphic cursor will display. 
 

 
 

Position the cursor to the desired location.  
 

Click to place.  
 
 
 
 
 
 

The Cake logo now appears on the label. 
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Step 5. - Add a Rectangle 
 

This step will place a rectangle on the label. 
 

 
 
 

Click   to add a rectangle. A crosshairs (+) cursor will now appear on the screen. 
 

 
 
 

Position the crosshairs at the starting position of the rectangle.  
 

Press and hold the left-mouse button.  
 

Move the mouse diagonally to draw a rectangle.  
 

Release mouse button when finished. 
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The rectangle now appears on the label. 
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Step 6. - Add a Line 
 
This step will draw a line on the label. 
 

 
 
 
 
 

Click  - A crosshairs cursor will appear on the screen. 
 

 
 

Position the crosshairs at the starting position of the line.  
 

Press and hold the left-mouse button.  
 

Move the mouse horizontally or vertically to draw a line. 
 

Release mouse button when finished. 
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The line now appears on the label. 
 

 
 
 

 
  



Quick Start 

 15 

Step 7. - Save the Label 

To save the currently open label design at any time, click the Save Icon    on the 
Toolbar, or select File> Save Label Format. 
 

‘Format Saved’ will display in the status bar (lower-left corner). 
 
 
 
 
 

Step 8. - Test Print 

To print a test label, click on the Test Print Icon , or Select File> Test Print. 
 
 

The Select Printer window will display.  
 

 
 
 

Select either a local Windows printer or an iSeries printer from the list.  
 

Select the number of copies to print. 
 

Click OK. 
 
 
 
 
 
 
 
 

NOTE: iSeries printers must be configured in Barcode400 on the iSeries in the Utility Menu under 
Printer Configuration. 

 
 

QUICK TROUBLESHOOOTING – If the label does not print, confirm the printer is connected properly 
and the iSeries outque is active. Otherwise, contact T.L. Ashford Technical Support 800.541.4893 
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1. Overview 
 
Barcode400 is a bar code label design and printing application for the IBMi mid-range 
computer systems. The Graphical Label Designer allows users to create new or edit 
existing labels on the IBMi, via the PC, in a Windows desktop publishing environment. 
 
The Designer creates custom label layouts referred to as “Label Formats”. Each label 
format is stored on the IBMi (not the PC) under a unique user-assigned name. 
 
 

1.1 Using this Manual 
 

This manual details barcode label design using Barcode400’s Graphical Label Designer, 
including creating a label format, adding design elements (text, barcodes, graphics, lines, 
etc.), integrating various data, and printing formats using diverse printing methods. 
 
The book is intended for both beginning and experienced users, who will creating and 
printing barcode labels. Users do NOT need programming experience. 
 
 
The manual covers: 
 

Format Design – Create and edit label layouts 

Label Elements – Add and change various objects on the format 

Format Options – Copy, Delete, Rename, and Save formats 

Label Printing – Produce labels from Test Print 

Graphics / Overlays – Add and use static and variable images and watermarks 

Merged Data – Retrieve and use data from an IBMi database file 

Incrementing Numbers – Create and use a control number 

Paragraphs - Add and use static and variable blocks of text 

Printing Labels – Producing formats from menu options or applications 

Supported Printers – Lists printer types and the programs to call 

 

1.2 Helper Guide 
 

Throughout the manual, you may encounter these Helper icons. 
 

 
 Note – Reminders to give you a heads up or helpful tip. 

 Quick Troubleshooting – These notices can resolve potential minor issues. 

 Warning – Please read these caution messages before performing an action. 
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1.3 Requirements 
 

Requirements for the installation and operation of the Barcode400 Graphical Interface: 
 
 
IBMi: 
 
OS/400 Version 5.3 or higher 
 
 
PC Hardware: 
 
IBM-Compatible PC 
 

 Intel or AMD DualCore 

2 GB Available RAM, (4 GB preferred) 

 196 MB of free Hard Drive space  

 
 
PC Software: 
 
Operating System 
 

Windows XP Home   (XP Service Pack 2 is required by .Net Framework Version 2) 

Windows XP Professional   (XP Service Pack 2 is required by .Net Framework Version 2) 

Windows 7  (32 and 64-bit) 

Windows 8 (32 and 64-bit) 

 
Web Services 
 

Microsoft .Net Framework – Version 2.0.5 & 3.5 

Java – Build 1.5 or newer 
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2. Starting the Graphical Label Designer 
 

Before designing and printing bar code labels, a user must Sign On to the  
Barcode400 Designer. In Windows, click Start, All Programs, T.L. Ashford and Associates, 
Barcode400 then Barcode4001 Graphical Interface.  
 
 
The Server Signon screen will appear. 
 

 
 

2.1 Server SignOn 
 

First-time users will need to create a server connection. See Add Server if not listed. 
 

  
 
 

At the SignOn Screen, enter the iSeries Userid and Password. 
 
 

Click SignOn. 
 
 
 
 
 

NOTE: If you do not have an iSeries Userid, contact a System Administrator. 
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2.2 Server Connections 
 

Barcode400 connects to one server at a time, but multiple servers can be defined.  Server 
Connections are set on the Server Signon window under Server Connections. 
 
 

 
 
 
 

Select the Server Connections tab on the Server SignOn screen. 
 
 

Check the desired Server Connection. 
 
 
Click OK. 
 
 
 
 
 

NOTE: Duplicate IP addresses will only be listed once. 
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Add Server to the Server Connections List 
 
 

From the Server SignOn Screen, select Server Connections then click Add Server. 
 

 
 
 

Enter the iSeries IP address (Mandatory). 
 

Enter or Select the Server Name (Optional).  
 

 
Server Type defaults to OS400. 
 
 
Enter a Description, if desired (Optional). 
 
 

Click OK. 
 

 
The new connection will be added to the Server List. Check the appropriate box to select 
the new server.  
 
You can now sign on. 
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Modify a Server Connection 
 

Under Server Connections, right-click or double-click on the Server to be changed. 
 

Select Edit. 
 
 

 
 
 

Make desired changes to Server setting. 
 

Click OK to save changes. 
 
 

 
 
 

Delete Server Connection 
 
 

Under Server Connections, right-click or double-click on the server to be deleted. 
 
 

Select Delete. 
 
 

Click OK to confirm Delete. 
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3. Label Directory 
 

To view available labels, click the Format Directory  button in the Toolbar.  
 

 
 
 
 

The Format Directory will display. 
 

 
  
 

The directory will display the formats from the iSeries the GUI is currently connected to. 
 
 

You can Edit, Copy, Rename and Delete any of the formats listed. If directory exceeds the 
display area, you can scroll-right or use the Search window to locate a format.  
 
 

Click Cancel to close.  

Format 

Directory 
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3.1 Edit an Existing Label 
 

An existing label format can edited from the Format Directory. Highlight to select the 
label format to be edited. 
  
  

 
 
 

Click Open.  
 
 
 

3.2 Save Label Format 
 
 

The Label Format can be saved to the iSeries anytime during the design process. 
 
 

Click the Save   button in the Toolbar.   
 
 

or 
 

 

Click File in the Menubar. Then, click Save Label Format. 
 
 
The current label format will save and remain open.  
 
 
 
‘Format Saved’ will appear in the lower-left of the Design screen. 
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3.3 Save Label As… in Edit Mode 
 

It is also possible to Save As… a label format, while editing. This will allow you to save 
the format under a new name. 
 
 

Click anywhere in white space on the label. This will display the Properties Panel. 
 
 

 

 
 

 

Click in the Label Format Name box in the Label Properties Panel, on the right.   
 

 
Enter new label name*, then click Save. 

*New name must be 8-bytes or less. 

 
 
 

The new label name is saved in the Label Directory. 

 
 

 

3.4 Close Format 
 
 

Close will end the design session for the currently selected label. 
 
 

Click File in the Menubar. 
 >Close Current Label Format. 
 
 
 

The software will prompt to save changes to the format. Click Yes or No to continue. 
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3.5 Copy Label Format 
 

Click the Format Directory button   in the Toolbar. 
 
 

 
 
 
 

In the Format Directory, right-click the format to be copied. 
 
 
 
 
 

Select Copy. 
 
 

 
 
 
 

Enter new format name*. Click OK. 
*New name must be 8-bytes or less. 
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3.6 Rename Label Format 
 

Click the Format Directory  button in the Toolbar. 
 
 

 
 
 
 

In the format directory, right-click on the format to be renamed. 
 
 
 
 

Select Rename. 
 
 

 
 
 

Enter new format name. Click OK. 
*New name must be 8-bytes or less. 
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3.7 Delete Label Format 
 

 
WARNING! Deleting a label format from the Graphical Designer’s Label Directory will also remove 
the format from the iSeries. 

 

 
 

Click the Format Directory  button in the Toolbar. 
 
 

 
 
 
 

In the format directory, right-click on the format to be deleted. 
 
 
 

Select Delete. 
 
 
 

Click OK to confirm Delete. 
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4. Label Design 
 

Labels are created by placing objects on a Label Format.  
  
 

4.1 Label Objects 
 
Each object on a label format has its own properties and may have a data source. 
 

There are nine types of objects: 
  

Text 

Multi-Line Text 

Bar Codes 

Lines 

Rectangles 

Graphics 

Overlays (HP/AFP-Compatible Printers Only) 

Stored Paragraphs 

RFID (Radio Frequency Identification) 

 
 
Objects may consist of static or variable data.  
 

Static data is data that remains the same each time a label prints.  

Variable data is data that may change each time a label prints and utilizes a  
Data Source. 

 
 
 

4.2 Data Sources 
 
Variable data can come from a variety of sources:  
 
 

Merge data is retrieved from an iSeries file (physical, logical, structure or program). 

Prompted data is entered by the user at print time via prompts added to the label. 

Incrementing Numbers are numbers defined within Barcode400 to serialize labels. 

System Date/Time are values retrieved from the iSeries at print time. 

Arrays are data files structured by byte position not fields. 
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4.3 Create New Label Format 
 
 

To create a new label format, click 
 
 
 
 

 
 
 
 

or Select File> Create New Label Format. 
 

  

New 

Format 
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A new label will open in the Design window, as shown below. 
 
 
 

 
 

 
 
 

Toolbars – These shortcuts allow the user to add new objects or perform edit functions. 
 
Design Canvas – This is the work area as defined by the Label Size. 
 
Properties Panel – Displays the settings for the format or a highlighted object. 

  

Properties 

Panel 
Design 

Canvas 

Tool 

Bars 
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4.4 Toolbars 
 

At the top of the Design Window are several toolbars for adding and editing label objects, 
as well as formatting functions. 
 

Object Toolbar 
 

 

              Object Toolbar 
 

To add an Object to the Label Design, select the appropriate button (barcode, text, lines, 
rectangles, graphics, stored paragraphs or RFID) from the Toolbar. 
 

Objects can also be added by selecting Edit > Add New Label Object. 
 

 

 Two-Dimensional Barcode – Add a Static or Variable 2D Barcode Symbol. 

 Linear Barcode – Add a Static or Variable Linear Barcode. 

 Text  - Add a Text Object with Static or Variable Data. 

 Multi-Line – Add a Multi-Line Text Object with Static and/or Variable Data 

 Line – Draw a Horizontal or Vertical line. 

 Rectangle – Draw a Rectangle. 

 Graphic – Add a Static or Variable Logo. 

 Stored Paragraph – Add, Create or Modify a Paragraph. 

 RFID – Encode an RFID SmartTag. (Additional Feature) 
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Edit Toolbars 
 

Edit Toolbars are specific to type of object being created or edited, such as text fields, 
barcode fields, multi-line text fields, or paragraphs. 
 
 

When any standard text is highlighted, this toolbar will appear. 
 
 

 
 

Text Edit Toolbar 
 
 

Increase Font Height – Click to make text taller. 

Decrease Font Height - Click to make text shorter. 

Increase Font Width - Click to make text wider. 

Decrease Font Width - Click to make text narrower. 

Rotate Text Left - Click to turn text object 90’ to the left. 

Rotate Text Right - Click to turn text object 90’ to the right. 

Reverse Image – Invert white text on a black background (See Reverse Image). 
 
 
 
 

When any Multi-Line Text object is high-lighted, this toolbar will appear. Note that the 
options are the same, except for two additions. 

 
 
 
 

Multi-Line Text Edit Toolbar 
 

 

 Increase Line Spacing – Click to insert more space between the lines of text. 

 Decrease Line Spacing - Click to decrease the space between the lines of text. 
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Barcode objects have their own set. Highlight a barcode for this toolbar to appear. 

 
 
 

Barcode Edit Toolbar 
 

  
Increase Bar Height – Click to make the bars taller. 

Decrease Bar Height - Click to make the bars shorter. 

Increase Barcode Width - Click to make symbol wider. 

Decrease Barcode Width - Click to make symbol narrower. 

Rotate Barcode Left – Click to turn the barcode to the left 90’. 

Rotate Barcode Right – Click to turn the barcode to the right 90’. 

 

 

Function Toolbar 
 

Many of the Graphical Designer’s menu functions are available directly from this toolbar. 
 
 
 

Function Toolbar 
 

 

 New Format - Click to create a new empty label. 

 Open Label Directory – Click to open/edit an existing label format. 

 Save - Click to save the currently open label. 

 Test Print - Click to print a Test Label to a selected printer. 

 Undo – Click to backtrack the last action taken. 

 Redo – Click to repeat the last action taken. 

 Cut – Click to remove the highlight object(s) and store them in the Clipboard. 

 Copy – Click to copy the highlight object(s) and store them in the Clipboard. 

 Paste - Click to place object(s) stored in the Clipboard on the label. 

 Delete – Click to remove the highlight object(s) from the label. 

 Zoom – Click to change the view magnification (50-500%). 

 Grid – Click to enable, disable or alter the Designer Dot Grid 
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4.5 Properties Panel 
 

During the design process, the Properties Panel will display the properties of a highlighted 
object on the format. If an object is not highlighted, Barcode400 displays the properties 
of the label itself in the Properties Panel to the right of the Design Canvas. 
 
 
 

Label Properties Panel 
 

These properties affect the entire label design. To display, click on the label canvas area. 
 
The Label Properties will appear in the grid to the right. 
 

 
 

 
Click on a property, then enter or select a new value. The format will automatically 
update to reflect the change. 
 
The Label Name, Description, Size, Target Printer Manufacturer and Model, as well as 
Form Type, Labels Across and Data Source can be updated from the properties grid. 
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4.6 Text Objects 
 

Text may consist of the following Data Sources: 
 

 Static Data 

 Merge Data 

 Prompted Data 

 System Date/Time 

 Incrementing Numbers   
 

 

Add Text 
 

Click    to Add Text Object 
 

 
 
 
The Text Field Properties window will display. 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Insert data into the Data field.  Static Data can be entered directly by typing in the 
desired text. Variable Data can be entered by selecting a Data Source from the Insert 
Variable Data Toolbar.  
 
Click OK to place the text object on the label. 
  

Data Field 

Font Type 

Rotation 

Reverse Image 

Special Format 

Prefix / Suffix 

Justification 

Data Source 

Font Expansion 

Add Text 
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Modify Text 
 
Text Objects are modified using the Text Field Properties Dialogbox or the Text Field 
Properties Panel. 
 
 

Text Field Properties Dialogbox 
 

To access the Text Field Properties, right-click on the Text Object and select Show 
Properties Dialogbox, or double-click on the Text Object. 
 
 

 
 
 
 

The Text Field Properties window will display. 
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Text Field Properties Panel 
 
Or, single-click on the Text Object. The Text Field Properties appear in the Properties Panel to 
the right. Click on a property to update its value, either from a drop-box or manual entry. 
 
 
The text field will automatically update. 
 

 
 
 

 
Properties for Text Objects:  
 

Position (X = Over, Y = Down) – Object’s starting position. 

Rotation – Orientation of the text field. 

Font – Letter type or style. 

Font Expansion (Width and Height) – Text size multiplier. 

Reverse Image – Inverted white text on black background. 

Justification – Text alignment and field length. 

Special Formatting – Special check digit functions. 

Data or Data Source – Static data or variable field. 

 

 

Details for these properties are on the following pages. 
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Font Overview 
 

Barcode400 supports printer resident fonts and downloadable True Type fonts. 
 
 

Printer Resident Fonts  
 
These fonts are created by the printer manufacturer and delivered as a standard option 
on the printer.  Printer resident fonts vary from printer manufacturer to printer 
manufacturer, and sometimes from model to model. 
 
 
 

True Type Fonts  
 
True Type fonts do NOT reside on a printer when the printer is delivered and must be 
downloaded to the printer. 
 
Barcode400 can download True Type fonts to the printer, provided that the printer has 
the necessary memory. True Type fonts are supported on the following printer brands:  
Zebra, Datamax/Oneil, Monarch, IBM and Printronix.   
 
These fonts can be downloaded to the printer using the Font Installation program included 
with the iSeries software. True Type fonts only need to be downloaded once and remain 
stored on the printer for future use.  
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Font Selection 
 

Fonts can be selected or changed in the Text Properties Dialogbox or Properties Panel. 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
The available fonts displays on the upper-left. The Font Tree is determined by the 
format’s Target Printer. Click on a font from the tree to select. 
 

 

 

Font Expansion 
 

Font Expansion allows for a greater variety of font sizes by multiplying the font’s base 
height and width values.   
 
Font Expansion can be selected or changed in the Text Properties Dialogbox or the Text 
Properties Panel. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

In the Font Expansion box, select the desired Height and Width expansion by setting the 
up and down arrows from 1-9. Each font defaults to Height and Width of 1. 
  

  Printer Resident Fonts 

 True Type Fonts (Download) 

 

Font Tree 

Font Expansion 
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Reverse Image 
 

Reverse Image is when characters appear in white on a black background.  Reverse image 
can be applied only to a text field.  
 

 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
Click the check box to turn on Reverse Image.  
 
 
 
 

NOTE: Not all fonts support Reverse Image. 
 

  

Reverse Image 
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Rotate Text 
 

Text can be rotated at 0, 90, 180, or 270 degrees using the Rotation feature in the Text 
Properties DialogBox or the Text Properties Panel. 
 

 
 
 
 

NOTE: Due to potential text alignment issues, 90 degrees is recommended over 270 degrees, when 
designing a rotated label format. 

 

 

 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
Select the desired Rotation. Click OK 
 

  

Rotation 
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Justification 
  

The Justification in Area option will format text data and justify left, right or center 
within a set area based on width.  
 
By default, all text objects with a 0 or 90 degree rotation are Left justified. Any other 
option will require Enabling the Justification option. Click the Check Box to Enable. 
 
 

 
 
 

Once enabled, check the Center or Right option. The data will center or right-justify 
within the Area Width determined, as opposed to the width of the entire format. 
 

Area Width sets the size of the field in tenths of inches. This allows for fields to be 
organized into columns or restrict field size within the format borders. 
 

In the example, a 3.8” Area Width was set to Center on a 4” label format. Note the field’s 
boundary shows the full 3.8” area indicated with the text centered. 
 
 

 
  

Justification 
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Special Formatting 
 

Special Formatting will format a text field to include spaces and even add a human 
readable check digit as part of a compliance requirement.  
 
 

Barcode400 can format data according to these specifications:   
 

UCC/SSCC-18 (GS-1 / SSCC-18 Serial Shipping Container)  
UPC/SCC (GTIN-14 / UPC Container) 
UPS (United Parcel Service Ground Tracker) 

 
 
Special formatting can be applied only to a text entry field.   
 
 

Text can be any combination of constant data, merge fields, prompted fields and 
incrementing numbers.  The data to be printed must comply with the specifications 
outlined in the next section. 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
Click the Special Formatting drop down arrow. Select desired format option. 
 
 

Click OK. 
 
(See Specifications on the following page).   

  

Special Format 
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Special Formatting Specifications 
 

This page details the Special Formatting text options. 
 
 

GS1 or UCC/SSCC 
 

 
 

19 digits must be passed in the data.  Barcode400 will print a total of 20 digits spaced 
according to UCC/SSCC specifications. The 20th digit is a Mod10 check digit. 
 

Data =     0001234567123456789 
Prints =   00 0 1234567 123456789 3* 

*The (  ) were created separately. 
 

GTIN or UPC/SCC 
 

 
 

13 digits must be passed in the data.  Barcode400 will print a total of 14 digits spaced 
according to UPC/SCC specifications.  The 14th digit is a Mod10 check digit. 
 

Data =    1001234567890 
Prints = 1 0012345 67890 2 
 
 

UPS Ground Tracker 
 

 
 

17 characters must be passed in the data.  Barcode400 will print a total of 18 digits 
spaced according to UPS specifications.  The 18th digit is a Mod10 check digit. 
 

Data =   1Z1235E0031234567 
Prints = 1Z 123 5E0 03 1234 5671 
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Extended Characters 
 

Extended characters are values that may not appear on the keyboard but can be inserted 
into the Data Line, Prefix or Suffix. 
 
 
Click in the Data section of the Properties DialogBox.  
 
 

Click on the  button in the right corner of the Data line. 
 
 

Select Extended Characters. 
 
 
 
The Extended Character Chart will appear. 
 

 
 
 
 

Select the desired character.  The character will appear in the Data section.   
 
 

 

Click  to close Extended Characters window. 
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Data Source 
 
Static Data can be entered directly by typing in the desired text.  
 

Variable Data can be entered by selecting from the Insert Variable Data Toolbar. 
 
 

 
 

 
 From File – Merged Data 
 

 Prompt Field – Operator Prompted Data 
 

 Date / Time – iSeries System Data 
 

 Incrementing # - Control number / Counters 
 

 Array – Structured Merge Data 
 
See Data Sources for more detailed information. 
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4.7 Multi-Line Text Objects 
  

Multi-Line Text Objects allow several values to be incorporated into a single label object 
(Ex. Shipping Address). They may consist of the following Data Sources: 
 

 Static Data 

 Merge Data 

 Prompted Data  

 System Date/Time 
 

 

Add Multi-Line Text 
 

Click    to Add a Multi-Line Text Object 
 

 
 

The Multi-Line Text Field Properties window will display. 
 
 

 
 
 

Insert data into the Data field.  Static Data can be entered directly by typing in the 
desired text. Variable Data can be entered by selecting from the Variable Data Toolbar.  
 
Click OK to place the text object on the label. 

Data Field 

Properties 

Variable 

Data 

Add  
Multi-Line 

Text 
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Modify Text 
 
Multi-Line Text Objects are modified using the Multi-Line Text Field Properties Dialogbox 
or the Multi-Line Text Field Properties Panel. 
 
 
 

Multi-Line Text Field Properties Dialogbox 
 

To access the Multi-Line Text Field Properties, right-click on the Multi-Line Text Object 
and select Show Properties Dialogbox, or double-click on the Multi-Line Text Object. 
 
 

 
 
 
 

The Multi-Line Text Field Properties window will display. 
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Multi-Line Text Field Properties Panel 
 

Or, single-click on the Multi-Line Text Object.  
 
The Multi-Line Text Field Properties appear in the Properties Panel to the right. Click on a 
property to update its value, either from a drop-box or manual entry. 
 
The multi-line text field on the label will automatically update. 
 

 
 
 

Properties for Multi-Line Text Objects:  
 

Position (X = Over, Y = Down) – Object’s starting position. 

Rotation – Object’s orientation. 

Font Type – Letter type or style. 

Font Expansion (Width and Height) – Text size multiplier. 

Line Spacing – Sets the amount of dots between each line. 

Data or Data Source – Static data or variable field. 
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Multi-Line Font Selection 
 

Fonts can be selected in the Multi-Line Text Properties Dialogbox or Properties Panel. 
 
In the Properties Dialogbox, click the Edit Properties button. The properties will display. 
 

 
 

 

As with Text Objects, a font must be selected from a drop-box. The font options are 
based on the Target Printer.  
 

 
NOTE: The font selected will be used for all of the text in the same Multi-Line object. 

 
 
 

Multi-line Objects also have a Line Spacing option which determines the distance between 
each line in 1/100th of inches. 
 
 

Data Source 
 
Static Data can be entered directly by typing in the desired text. Variable Data can be 
entered by selecting from the Insert Variable Data Toolbar. 
 
 

 
 

 From File – Merged Data 
 

 Prompt Field – Operator Prompted Data 
 

 Date / Time – iSeries System Data 
 
See Data Sources for more detailed information. 
  

Font Type 

Rotation 

Line Spacing 

Font Expansion 
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4.8 Linear Bar Codes 
 

Bar Codes may consist of: 
 

 Static Data 

 Merge Data 

 Incrementing Numbers 

 System Date/Time 

 Prompted Data  
 
Barcode400 distinguishes between linear 1-Dimensional bar codes and 2-Dimensional bar 
codes. (See 2-Dimensional Bar Codes) 
 
 

Add Linear Bar Code 
 

Click  to add a Linear Barcode. 
  

 
 

The Barcode Properties will display. 
 

 
 
Insert data into the Data field, Prefix and Suffix fields. Static Data can be entered directly by 
typing in the desired text. Click OK to place the Barcode Object on the label.  

Barcode 

Symbology 

Data 

Fields 

Rotation 

Height / 

Width 

Human 

Readable 

Add 

Barcode 
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Modify Linear Barcode Properties 
 

Bar Code Properties are adjusted using the Barcode Properties Dialogbox or the Bar Code 
Properties Panel. 
 
 

Bar Code Properties Dialogbox 
 

To access the Properties Dialogbox, right-click on the Bar Code Object and select Show 
Properties Dialogbox, or double-click on the Bar Code Object.  
 
 

 
 
 
 
 

The Bar Code Field Properties window will display. 
 
 

 
 
 
 
 

QUICK TROUBLESHOOTING – If the barcode displays a Red X after being placed on the label, this is a 
warning of a potential error based on the barcode’s type and data. Confirm that the type and 
amount of data being encoded meets the barcode’s requirements. 
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Bar Code Properties Panel 
 

Single-click on the Barcode Object. The Barcode Field Properties appear in the Properties 
Panel to the right. Click on a property to update its value, either from a drop-box or 
manual entry. 
 
The barcode will automatically update. 
 

 
 
 

Properties for Barcode Objects:  
 

Position (X = Over, Y = Down) – Object’s starting position. 

Rotation (0, 90, 180 or 270 degrees) – Object’s orientation. 

Symbology - Barcode types, listed by type. 

Barcode Height - Bar height in tenths of inches. 

Narrow Bar Width - Bar width in dots, increases overall symbol width. 

Human Readable - Turn on or off the text beneath the bars. 

Check Digit - Security value added to the end of the symbol. 

Aspect Ratio - Narrow to wide bar size ratio. 

Data or Data Source – Static data or variable field. 

 
 
These values are detailed on the following pages. 
 
 
 

NOTE: Not all options will be available for all barcode symbologies. 
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Bar Code Symbology Overview 
 

Bar Code symbology is set in the Bar Code Properties DialogBox or the Bar Code Properties 
Panel.  The symbology is the method bars and spaces are structured to encode data into a 
bar code.  Some bar code symbologies require specific types or amounts of data.   
 

 
 

Supported Linear Symbologies 
 

Barcode400 supports the following linear symbologies. 
 

Type Description Check Digit Data Length 

A Code 39 (1:3 ratio) None Alpha 1-40 

Q Code 39 (2:5 ratio) None Alpha 1-40 

Y Code 39 (1:2 ratio) None Alpha 1-40 

2 Code 93 None Alpha 1-100 

0 Code 128 Subset A None Alpha 1-40 

Z Code 128 Subset B None Alpha 1-40 

1 Code 128 Subset C  None Numeric 2-40 

f Code 128 Subset C w / FNC1 Mod103 Numeric 2-40 

W Code 128 Subset C / SSCC-18 Mod10/Mod103 Numeric    19 

u Code 128 Subset C / UPS Mod10 Alpha    17 

F MSI None Numeric 14 

M Plessey None 0-9, A-F 100 

# Postnet None Numeric 9 

D Codabar None Numeric  1-100 

U EAN-8 Mod10 Numeric      7 

T EAN-13 Mod10 Numeric    12 

3 HIBC (Code 39) Mod43 Alpha 1-40 

K Interleaved 2 of 5 (1:3 ratio) None Numeric    2-40 

r Interleaved 2 of 5 (1:2 ratio) None Numeric    2-40 

a Interleaved 2 of 5 (1:3 ratio) Mod10 Numeric    2-40 

i Interleaved 2 of 5 (2:5 ratio) None Numeric    2-40 

P UPC-A Mod10 Numeric    11 

R UPC-E / E1 Mod10 Numeric    10 

b UPC-2 Digit Addendum None Numeric      2 

c UPC-5 Digit Addendum None Numeric      5 

9 UPC Container  (SCC / GTIN-14) Mod10 Numeric 13 
 
 
 

 
NOTE: Barcode400’s iSeries Designer supports some additional, older legacy symbologies not shown 
in the Graphical Designer’s barcode list. 

 
 

For more details on the symbologies listed, See Appendix A. 



Label Design 

 56 

 

 
Linear Bar Code Symbology 
 
 

To select a bar code symbology, click            to add a new Bar Code Object or right-click 
an existing Bar Code Object > Select Show Properties DialogBox or double-click on it. 
 
 

 
 

 

The available bar code symbologies displays on the upper left.  
 
 
Click the scroll bar to display bar code types, and then select the symbology.  Notice the 
description at the bottom of the Properties Box with a description of the bar code type. 
 
  

Symbology 



Label Design 

 57 

 
Bar Code Height 
 

Bar Code Height is set in the Bar Code Properties DialogBox or the Bar Code Properties 
Panel.  Bar Code height increments are made in tenths of an inch. 
 

 

 

Select the desired bar code height (in inches and tenths of inches). 
 

 

 

Bar Code Width 
 

Bar Code Width refers to the width of the narrowest bar in a bar code. The widths of all 
other bars are based on this value. It is measured in mil (1/1000th of inch) and also 
referred to as the X-dimension.  (Also See Ratio). 
 

 
 
 
 

Select the desired bar code width (in dots).  

Barcode 

Height 

Narrow Bar 

Width 
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Human Readable 
 

Selecting Human Readable for a bar code will cause the data being encoded in the bar 
code to also print as text.  
 

When selecting Human Readable, the human readable text will print directly below the 
bar code in a default font based on the printer brand and the size of the barcode.  
 
If the human readable is required in a different location, font type or size, select NO for 
this option, but place the "human readable" on the label as a separate Text Object.  
 
 
 
 

NOTE: UCC/SCC, UPC/SCC, and UPS compliance labels require specially formatted human readable 
text.  In these instances, select NO for human readable. (See Special Formatting) 

 
 

 
 
This option can be set in the Barcode Properties DialogBox or Bar Code Properties Panel. 
 
 

 
 
 
 

Select Human Readable Yes or No.   
 
  

Human 

Readable 
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Bar Code Rotation 
 

Bar Codes can be rotated 0, 90, 180, or 270 degrees using the Rotation feature in the 
Barcode Properties DialogBox or the Bar Code Properties Panel. 
 
 

 
 
 
 

Select the desired rotation. 
 
 

 
 
 
 
 

NOTE: Barcodes can scan from any orientation. The data will always read the same. 
  

Rotation 
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Check Digit 
 

Barcode400 supports check digit function for barcodes. Check digits are calculations 
performed in a bar code to help ensure the integrity of the encoded data.  
 

Some bar codes automatically contain check digits, for instance, the UPC-A or Code128 
UCC Shipping Container Code will not have a Check Digit option.   
 
 
 

Types of Check Digits 
 

There are two primary Check Digit types.  
 

Code 39 (3 of 9) bar code has an optional Modulus 43 (or Mod43) check digit.   
 

Interleaved 2 of 5 and Code128 bar code symbologies support an optional Modulus 10 
(Mod10) check digit.  
 

 
Code128 also has an internal Mod103 self-test, but does NOT add any data to the barcode.  
 
 
 
 

NOTE: If you do NOT see the Check Digit type listed, the Bar Code Symbology does not support a 
Check Digit. 
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Ratio 
 

The Bar Code ratio refers to the difference between the width of the narrowest bar in the 
bar code (See Bar Code Width) and the widest bar.   
 

Only the Interleaved 2 of 5 and Code 39 symbologies have variable ratios which can be set 
dependent upon the symbology selected. 
 

The ratio can also be set in the Bar Code Properties DialogBox. 
 

 
 
 
 

Data Source 
 
Static Data can be entered directly by typing in the desired text.  
 

Variable Data can be entered by selecting from the Insert Variable Data Toolbar. 
 
 

 
 

 
 From File – Merged Data 
 

 Prompt Field – Operator Prompted Data 
 

 Date / Time – iSeries System Data 
 

 Incrementing # - Control number / Counters 
 

 Array – Structure Merged Data 
 
 

See Data Sources for more detailed information. 

  

Aspect 
Ratio 
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4.9 2-Dimensional Bar Codes 
 
With the need to produce more data in a smaller space, developers created symbologies 
that combine multiple fields into a structure that uses less space, yet maintain integrity. 
 
By using matrixes or image patterns, barcodes could be scanned vertically as well as 
horizontally and allow more information to be stored. 
 

 

Adding a 2-Dimensional Bar Code 
 
Click the Add 2-Dimensional Bar Code button in the toolbar. 
 

 
 

Select the type of 2-Dimensional Barcode. 
 

 
 

The specific 2-Dimensional Bar Code properties will display. Consult the following pages 
for details of each symbology. Once completed, click OK.   
 
 

 
The crosshairs cursor will appear. 
 

 
 

Position the cursor to place the 2-Dimensional bar code and then click. 
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The completed 2-Dimensional bar code will appear on the label. 
 

 
 
 

Supported 2-Dimensional Bar Code Symbologies 
 

Barcode400’s Graphical Label Designer supports the most popular 2-dimensional symbols. 
 

 

Name Type Data Length 

Data Matrix Q Alpha 1-2,335 

PDF-417  E Alpha 1-1,100 

QR Code q Alpha 1-2,900 

UPS Maxicode X Alpha 84-100 
 

 

Data Source 
 

Static Data can be entered directly by typing in the desired text. Variable Data can be 
entered by selecting from the Insert Variable Data Toolbar. 
 
 

 
    
 

 From File – Merged Data 
 

 Prompt Field – Operator Prompted Data 
 

 Date / Time – iSeries System Data 
 
 

See Data Sources for more details. 
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Data Matrix Properties 
 

Data Matrix may consist of  
 

 Static Data 

 Merge Data 

 System Date/Time 

 Prompted Data  
 

 
Data Matrix Properties 
 

 Element Size (affects overall size of the bar code) 

 ECC (Error Correction Capability) Level 

 Rotation - rotates the Data Matrix symbol to 90, 180 or 270 degrees. 

 Data – Content to be encoded inside the symbol. Data can be combined from 
various sources both constant and variable. 

 
 
 
 

NOTE:  All data to be encoded must be surrounded by {  }.  Any data residing outside of {  } is 
considered user documentation or comment. 

 
 
 

Bar Code Properties Dialogbox 
 

Right-click on the Data Matrix bar code object. 
 

Select Show Properties DialogBox. 
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Maxicode Properties 
 

Maxicode may consist of  
 

 Static Data 

 Merge Data 

 System Date/Time 

 Prompted Data  
 

 
 
Maxicode Properties 
 
Unlike other two-dimensional bar codes, UPS Maxicode has a rigid data structure.  
 

The specific list of data fields are set in an exact order to more efficiently perform the 
function of automatically sorting parcels for shipping. 
 
 

 Mode   Maxicodes are either Mode 2 (Domestic) or 3  
for (International) 

 Class   3-digit Service Code (Ex. 001 = Next Day Air) 

 Country  3-digit Destination   (Ex. 840 = United States) 

 Postal Code  9-digit Postal Code   (6 digits for International) 

 Tracking Number 10-digit Parcel Number  (Including a static 1Z prefix) 

 SCAC   4-digit Carrier Code  (Defaults to ‘UPSN’) 

 UPS Account   5-digit Shipper ID# 

 Julian Pickup  3-digit day of the year 

 Shipment ID  Optional Consignment Number 

 Package Number 3-digit / 3-digit Package of Number 

 Package Weight 3-digit weight in kilos  (Rounded up) 

 Address Validation (Y/N) Address verified (Defaults to ‘N’) 

 Street   Optional Street Name and Number 

 City   1-25 character City Name 

 State   2-character State Abbreviation 
 
 

 

For more details on the United Parcel Service requirements for the Maxicode, consult the 
UPS Guide to Labeling or contact a UPS representative.  
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Bar Code Properties Dialogbox 
 

Right-click on the Maxicode bar code object. 
 
Select Show Properties DialogBox. 
 

 
 
 
 
 
 

NOTE: The Tracking Number must include a static 1Z prefixing any data (Ex: 1ZM¦10). The 
Shipment ID Number and Street Address are optional fields. They are not required. 
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PDF-417 Properties 
 

PDF-417s may consist of  
 

 Constants 

 Merge Data 

 System Date/Time 

 Prompted Data  
 

 
 
PDF-417 Properties 
 

 Maximum Columns - indicates the number of columns to encode the PDF symbol.  
Increasing the number of columns will produce a wider, but shorter bar code. 

 

 Security Level – To minimize encoding errors, PDF-417 encodes the data in the 
symbol redundantly. The level of security is the number of times the data is 
repeated and compared inside the symbol. 

 

 Rotation - rotates the PDF symbol to 90, 180 or 270 degrees. 
 

 Element Width - width of the narrow bar expressed in dots.  Increasing the element 
width will increase the width of the PDF symbol. 

 

 Element Height - height of the row expressed in dots.  Increasing the element 
height will increase the height of the PDF symbol. 

 

 Truncate - omits the right row indicators and the stop pattern will be reduced to 
one module width bar. 

 

 Data – Content to be encoded inside the symbol. Data can be combined from 
various sources both constant and variable. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOTE:  All data to be encoded must be surrounded by {  }.  Any data residing outside of {  } is 
considered user documentation or comment. More than one set of { } may be needed and can be 
used to organize data. 

 

  



Label Design 

 68 

 
Bar Code Properties Dialogbox 
 

Right-click on the PDF-417 bar code object. 
 
 

Select Show Properties DialogBox. 
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QR Code Properties 
 

QR Codes may consist of  
 

 Constants 

 Merge Data 

 System Date/Time 

 Prompted Data  
 

 

QR Code Properties 
 

 Size (Magnification) - indicates the size of the elements (boxes) that comprise the 
symbol. Increasing this value will increase the overall size of the symbol. 

 

 ECC Level  – Sets the Error Correction level of the symbol. Defaults to M. 
 

 Rotation - rotates the PDF symbol to 90, 180 or 270 degrees. 
 

 Data – Content to be encoded inside the symbol. Data can be combined from 
various sources both constant and variable. 

 
 
 
 
 

NOTE:  All data to be encoded must be surrounded by {  }.  Any data residing outside of {  } is 
considered user documentation or comment. 
 
 

 

Bar Code Properties Dialogbox 
 

Right-click on the QR Code object. 
 
 

Select Show Properties DialogBox. 
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Special Characters 
 

Special Characters are values for non-English characters and functions that are often 
required in a 2-dimensional bar code. Functions do not scan as traditional characters.  
 

 
 

 

Insert Special Character (PDF-417, Data Matrix, QR Code) 
 

Click in the data section of the Properties DialogBox for the bar code.  
 

Click on the  button in the right corner of the Data line. 
 

Select Extended Characters. 
 

Double click the desired special character.  The selected character will appear in the 
Data section. 

 

Click  to close Extended Characters window. 
 

 
 

 

Insert Special Character (Maxicode) 
 

Click on the field to be edited in the Properties DialogBox for the bar code.   
 

In the field prompt, click the  button in the right corner of the Data line. 
 

Select Extended Characters 
 

Double click the desired special character.  The selected character will appear in the 
Data section.   
 
  

Click  to close Extended Characters window. 
 

 
NOTE: In order for Special Characters to be encoded, they must be enclosed within { }. 
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4.10 Lines 

 
Horizontal and vertical lines can be drawn directly onto a label format. The user 
determines length, position and thickness. 
 

 

Add Line  
 

Click  in the Toolbar. The crosshairs will appear. 
 

 
 

Move the crosshairs cursor ( + ) to the starting position.   
 
 
 

Click and hold, then drag to draw line horizontally or vertically. 
 

 
 

Release the mouse button to complete the line. 
 
 
 
 

NOTE: Lines can only be drawn horizontal and vertical.  
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Change Line Properties 
 

Click on the line to highlight it. 
 

 
 

Use the Pull bars to adjust the line length and thickness. Also, by holding down the mouse 
button, the line can be dragged to a new position. 
 
 
 

Right-click on the line and a pop-up menu appears. 
 

 
 
 

From this pop-up, a line can be Cut and Paste as well as Copied or Deleted.  
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4.11 Rectangles 
 

Rectangles can be drawn directly onto the label format. The user can determine height, 
width, position and line thickness. 
 

 

Add Rectangle 
 

Click  in the Toolbar. 
 

Move the cursor, now appearing as crosshairs  ( + ), onto the label.   
 

Click and hold, then drag to draw a rectangle or box. 
 

 
 
 

Release the mouse button to complete the rectangle. 
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Change Rectangle Properties 
 

Click on the rectangle to highlight. 
 

 
 
 

Use the pull bars to adjust the box height and width.  
 
 

 
Right-click on the line and the pop-up menu appears. 
 

 
 
 

Click on the Show Properties DialogBox to change the Line Thickness, as well as the box’s 
dimensions and position. 
 
Also from this pop-up, a rectangle can be Cut and Paste as well as Copied or Deleted.  
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4.12 Graphics 
 

Graphics may appear as  
 

 Static Data 

 Merge data 

 Prompted data 
 

 

Graphics must be imported before being used on label formats. (See Import Graphic)  
Once imported, graphics are stored in the Graphic directory within Barcode400. This 
means any graphic once transferred into the software is available for use on any label. 
 
 

Add Static Graphic 
 

Click  to Add Graphic Object. 
 

The Add Graphic Menu will open. 
 

 
 
 

Select Static Graphic and the Graphics Directory will display. 
 

 
 
 

Select the image desired. Note the thumbnail image on the right for confirmation. 
 

Click Open and place graphic on format. 
 
 
 

NOTE:  Graphics cannot be rotated on the label format after transfer. Upload the image to the 
iSeries in the desired rotation first. 

  

Preview 
Pane 

Options 
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Add Variable Graphic 
 

Click  to Add Graphic Object. 
 

The Add Graphic Menu will open. 
 

 
 

Select Variable Graphic, then either Graphic Name is in Database Field or Entered by 
Operator at Print). 
 
 

Select either a Database Field or an Operator Prompt which will supply the graphic name. 
 
 
 
 
 
 
      or 
 
 
 
 
 
 
 
 

If there is a logo name in the Sample Data, that graphic will appear on the format. 
 
 

 
 

 

NOTE: If the sample data is not an existing logo name, you will be prompted to select one. 
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Change Graphic Properties 
 
 

 
 
 

Click on the Graphic and hold the left mouse button to drag the image to a new position. 

 
Also, right-click on the Graphic and the pop-up menu appears. 
 

 
 
 

From this pop-up, a Graphic can be Cut and Paste as well as Copied or Deleted.  
 
 
Properties for Graphic Objects:  
 

Position (X = Over, Y = Down) – Starting position of the graphic image. 

Expansion (Width and Height) – Height and Width Multiplier 

Rotation – Orientation of the graphic. Defaults to 0 degrees. 

Graphic or Data Source – Name of the image or variable field. 
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Adding HP/AFP-Compatible Graphics (Page Segments) 
 

Logos printed on an HP/AFP-Compatible label must be converted to Page Segments. Any 
image currently in the logo directory can be converted to an HP/AFP-Compatible format. 
 

 
 

 
In the Graphic Directory, right-click on the image to be converted. Click Create PagSeg. 
Be sure the format’s Target Printer is set to HP, otherwise this option will not display. 
 
 

 
 

The converted image can now be added on the label.  
 
 

 

 

NOTE: If this option is NOT available, contact your T.L. Ashford and Associates Sales 
Representative for information. 
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Graphic Directory 
 

Click   while editing or click Tools> Work with Graphics. 
 
The Graphic Directory will appear and display the available graphics. These images can be 
placed on any label, but also can be copied, renamed or deleted. 
 

 
 

 
 

Copying Graphics 
 

Click Tools from MenuBar, then Work With Graphics.  
 >In the Graphic Directory, right-click on the Graphic and select Copy. 
 

Enter the name of the Copy. The new Graphic will be added to the directory. 
 
 

NOTE: Graphic names can be up to 8 characters. 
 

 

 

Deleting Graphics 
 

Click Tools from MenuBar, then Work With Graphics.  
 >In the Graphic Directory, right-click on the Graphic and select Delete. 
 
 
 

WARNING: Deleting a Graphic will affect any and all formats using the Graphic. Confirm before 
removing any Graphic from the Graphic directory. 
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Renaming Graphics 
 

Click Tools from MenuBar, then Work With Graphics.  
 >In the Graphic Directory, right-click on the Graphic and select Rename. 
 

At the prompt, enter the Graphic’s new name. Click OK. 
 
 

NOTE: Renaming a Graphic will affect any and all formats using the original Graphic name. 
Confirm before renaming any Graphics from the Graphic directory. 

 

 

 

Import Graphic 
 

Before placing a graphic on a label format, the graphic must be imported from the local 
PC or network into the Barcode400 Labeling Software on the iSeries.  
 
Click Tools from the Menu Bar 
 >Work with Graphics 
 
or 
 

Click  to open the Graphic Directory. 
 
 
 
 

The current Graphic Directory will display. 
 

 
 
 
 

Click the Add Graphic to Server  button. 
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Browse the PC or Network to locate the Graphic(s) to be imported. 
 

 
 

 
Select the image to be transferred. 
 
Or 
 
Use the mouse button plus the CTRL or SHIFT keys to select multiple images to retrieve. 
 
Click Open. 
 
 

The Upload Graphics to Server window will appear with the selected image(s). 
 
 

 
 

 
When uploading a single image, notice the Upload Graphic to Server options. 

 

 Graphic name can be changed before graphic is uploaded to the iSeries (The name 
must be 8 bytes or shorter otherwise it will be truncated). Enter at New Name. 

 

 Description of graphic to be transferred (Optional). 
 

Allowed Image 
File Types 

.pcx, .jpg, .gif, 

.tif, .png, .bmp 



Label Design 

 82 

 

 Resize bar.  Drag left to make graphic smaller.  Drag right to make graphic larger. 
 

 Resize to fit.  If checked, Target Width and Target Height must be specified. The 
aspect ratio will remain locked. 

 

 Target Width and Target Height, used in conjunction with the Resize to Fit button, 
will size graphic to height and width specified. The aspect ratio is NOT locked. 

 
 
  NOTE: If the Resize slide is used after Resize to Fit, the graphic’s aspect ratio is reset. 

 
 

 Target Printers. If the graphic will be printed on any of the brands listed, all of 
those printer(s) must be checked; otherwise the image may not print. 

 

 Rotation* allows for the image to be rotated prior to upload.  The Rotation box 
must be checked if the graphic is to be printed at 90, 180, or 270 degrees.   

 

 View. Displays the printable image at 203, 300, or 400 dpi (dots per inch).  The 
image is displayed as it will print at the selected dpi. Please note this option on 
affects how the image is displayed. It will not alter the actual DPI density. 

 
 
When retrieving multiple images, Barcode400 will prompt to rename images before 
uploading, however Barcode400 will use default Graphic to Server Options for all images. 
 

 
 
 
Click Continue. 
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If an image already exists on the IBMi with the same name, the following pop-up appears. 
 
 

 
 
 
The new image can be set to Replace the original or a Different Name can be set or Skip 
to cancel the transfer of that image. 
 
 

 
Click Upload to Server. The image now appears in the Graphic Directory. If you do not see 

it listed, click the Refresh  icon. 
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4.13 Overlays 
 

An overlay is a template created from an image or document. It can be placed on a label 
design for HP/AFP-compatible printer and create the effect of a pre-printed form.  
 

Existing documents (.doc, .docx, .pdf) and graphics can be placed on a label using the 
Barcode400 Overlay Transfer Software. Contact a Sales Representative for information. 
 
 

Adding an Overlay 
 

This option is only available for AFP/HP-Compatible printers. To add a document or image 
that will function as an overlay; set the Target Printer of the label design to HP.  
 

In the Label Properties Panel, click on the option for Overlay Name. 
 

 
 

Click on the         symbol to add an overlay. This option ONLY appears if the Target 
Printer is set to HP. The Overlay directory now appears. 
 

 
  

Add Overlay 
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Select an existing Overlay from the Directory and click Open. 
 

 
 
The overlay will appear on the format.  
 
 

 
 

You can now add other elements to the format (text, barcodes, etc.). Though it appears 
as a watermark, when printed the overlay merges seamlessly into the label. 
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Overlay Directory 
 

The list of available overlays can only be displayed while editing an HP label format.  
 

 
 
 
 

In the format’s Properties Panel, click Overlay Name. The Overlay Directory will display. 
 

 

 
You can also Search for a specific Overlay by name. 
  

Add Overlay 



Label Design 

 87 

 
Copying an Overlay 
 
 

Click Overlay Name in the label Properties Panel.  
 >In the Overlay Directory, right-click on the Overlay and select Copy. 
 

 
 
 

Enter the name of the copy.  The name cannot exceed 8 characters. 
 
Click OK. 
 

 

 

 
Deleting an Overlay 
 
 

Click Overlay Name in the label Properties Panel.  
 >In the Overlay Directory, right-click on the Overlay and select Delete. 
 
 

 
 

 

If you still wish to remove the overlay, click OK. Otherwise, click Cancel. 
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Renaming an Overlay 
 
 

Click Overlay Name in the label Properties Panel.  
 >In the Overlay Directory, right-click on the Overlay and select Rename. 
 

 
 

 
If the Overlay is currently in use by any format(s), they will display in the above window. 
This means that those formats will have to be updated to use the renamed Overlay. 
 
Should you wish to continue, enter the new name. The name cannot exceed 8 characters. 
 
Click OK or click Cancel to keep the existing Overlay name. 
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Creating an Overlay 
 

To create a new overlay, you can import an Adobe Acrobat file (.pdf), Word document 
(.doc, .docx), or graphic (.bmp, .gif, .jpg, .tif, .png, and .pcx). 
 
In the Label Properties Panel, click on the option for Overlay Name. Click on the         
symbol to add an overlay. 

From the Overlay Directory, click on the Add icon  button, and then browse for the 
document or image, to be used for the overlay.  
 
 

NOTE: If the Add Overlay is grayed out, you do not have the optional Overlay Transfer Module. 
Contact a T.L. Ashford and Associates Sales Representative. 

 
 

 
 

 

Click Open to Retrieve. The image or document will appear. 
 

 
 

You can rename an overlay in the File Name box or even select a specific page from a 
larger document. Also, the image can be rotated, but must be before transferred.  
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Click Transfer File to create the overlay.  Overlay names must not exceed 8 characters 
and should not contain any special characters. Once the overlay image transfer is 
successful, you will receive the following confirmation. 
 

 
 

 
Click OK. 
 

 
 

 
The new overlay will now appear in the directory and can be added to the format(s). If it 

does not appear, click the Refresh  icon. 
 
 
 
 

Overlay Options 
 

Settings for Overlays can be adjusted under the Barcode400 Global Values menu. Click on 
the Options Menu, and then select Global Values. 
 
 

 
 

 

 
 
 
 
 

Under Designer Preferences, you can adjust the Overlay Color and Intensity. This affects 
the overlay’s watermark effect on screen to aid in design. The overlay will still appear in 
black at full intensity when printed. 
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4.14 Stored Paragraphs 
 

Stored Paragraphs are blocks of text placed on a label as a single object. Paragraphs could 
be detailed instructions, material lists, warnings, etc.  They may appear as: 
 

 Static Data 

 Merge data 

 Prompted data 
 

 

Stored Paragraphs must be created, either in the GUI Designer or in Barcode400’s green 
screen designer under Option 7 (Paragraph Maintenance). 
 
 

Add a Static Stored Paragraph 
 

Click  to Add a Store Paragraph. 
 
 

The Add Stored Paragraph Menu will open. 
 
 

 
 
 
 

Select Stored Paragraph. The Paragraph Directory will display. 
 
 

 
 
 

Any Stored Paragraph listed in the Directory can be Edited, Copied or Deleted.  
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Select the Stored Paragraph and click Open to place the Paragraph on the format. 
 
 

  



Label Design 

 93 

 
Add a Variable Stored Paragraph 
 

Click  to Add a Stored Paragraph. 
 
 

The Add Stored Paragraph Menu will open. 
 

 
 
 

Select Variable Stored Paragraph, then either Paragraph Name is in Database Field or 
Paragraph Name is Entered by Operator at Print to place on label. 
 
 

Select a Database Field or Operator Prompt which will supply the Stored Paragraph name. 
 

 
 
 
 
 
 
 
               or 
 
 
 
  
 
 

 
If there is a Stored Paragraph name in the Sample Data, that Stored Paragraph will appear 
on the format as well as Test Print.  
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Change Stored Paragraph Properties 
 

 
 
 

Click on the Stored Paragraph and hold the left mouse button to drag it to a new position. 

 
 

Also, right-click on the Stored Paragraph and the pop-up menu appears. 
 

 
 

From this pop-up, a Stored Paragraph can be Cut and Paste as well as Copied or Deleted. 

 
 

Properties for Stored Paragraph Objects:  
 

Position (X = Over, Y = Down) – The starting print position of the paragraph. 

Rotation – Sets the orientation of the paragraph 

Font – Determined which letter style will be used. 

Font Expansion (Width and Height) – Sets the height and width font multipliers. 

Stored Paragraph Name or Data Source – Name of the paragraph or variable field. 

Starting Line – Indicates the first line from the paragraph to start from. 

Number of Lines – Determines how many lines from the paragraph will appear. 

Spacing – Determines how many dots between each line. 
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Create New Stored Paragraph 
  
 

Click the Paragraph icon   
 
 
 

Click Create a New Stored Paragraph. 
 

 
 
 
 

The Edit a Stored Paragraph screen will appear. 
 

 
 
 
 

Word Wrap will force the text to wrap to the next line once it reaches the margin. 
The margin is shown by the Ruler Margin (red line). Check the box to Wrap. 

 

The Ruler Margin can be adjusted by holding down the left mouse button and 
dragging the line left or right. Word Wrap MUST be checked to adjust. 
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Select the Font Size from the Font Menu in the upper-right. Fonts listed are dependent 
upon the label’s Target Printer. 
 
 
Enter text in the Text Design Area. Once complete, click Save. 
 

 
 
 
 
 

When prompted, enter the Stored Paragraph’s name. Names can be up to 10 characters. 
Once the Stored Paragraph is saved, it will be added to the Paragraph Directory. 
 
 

 
 

 
Select the new Stored Paragraph to add it to the label design. 
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Editing Stored Paragraph 
 

Click Tools from MenuBar, and then Work With Paragraphs.  
 >In the Paragraph Directory, right-click on the Paragraph and select Edit. 
 

 

 
 
 
 

 
NOTE: Any changes to the Stored Paragraph will affect ALL formats using that   
Paragraph. If you need to make a variation, make a copy first under a new name. 

 

 
 

Copying Stored Paragraph 
 

Click Tools from MenuBar, and then Work With Paragraphs.  
 >In the Paragraph Directory, right-click on the Paragraph and select Copy. 
 
 

 

 
 
When prompted, enter the new Stored Paragraph’s name. Names can be up to 10 
characters. Once the new paragraph is saved, it will be added to the directory. 
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Deleting Stored Paragraph 
 

Click Tools from MenuBar, and then Work With Paragraphs.  
 >In the Paragraph Directory, right-click on the Paragraph and select Delete. 
 

 
 
 

WARNING: Deleting a Stored Paragraph will affect any and all formats using the Stored Paragraph. 
Confirm before removing any Stored Paragraph from the Paragraph directory. 
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Renaming Stored Paragraph 
 

Click Tools from MenuBar, and then Work With Paragraphs.  
 >In the Paragraph Directory, right-click on the Paragraph and select Rename. 
 
 

NOTE: Renaming a Stored Paragraph will affect any and all formats using the original Stored 
Paragraph’s name. Confirm before renaming any Stored Paragraphs from the Paragraph directory. 

 
 

 
 
 
When prompted, enter the Stored Paragraph’s name. Names can be up to 10 characters. 
Once the Stored Paragraph is saved, it will be added to the Paragraph Directory. 
 

 
 
Click OK. 
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4.15 Align 
 

Elements on a format can be uniformly aligned horizontally. First, highlight a group of at 
least two objects, by drawing a box around them with the mouse. 
 
In this example, the Test1 Text, Test2 Barcode and Cake graphic have been highlighted. 
Note that Align now available. 
 

 
 

By clicking the Align Button , the highlighted objects align themselves to the Left-
most object’s vertical position. 
 

 
  

Align 
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5. Data Sources 
 

Data Sources are accessed to create variable objects on a label.  The Data Source 
determines what data will be used and from where.  Data can be accessed by merging 
fields from an iSeries file. Labels can be serialized using incrementing numbers.  The 
iSeries system date and/or time can be used, or prompts can be created where users 
enter data at print time. 
 

 

Data Sources are accessed by displaying the object's properties. 
 
 

Properties Dialogbox 

 

Right-click on the object.  
 

>Show Properties DialogBox. 
 
 

 
In the lower-left of the Properties Dialogbox, the Variable Data options will display. 
 
 

 
 
 
 

 From File – Merged Data Fields 
 

 Prompt Field – Operator Prompted Data 
 

 Date / Time – iSeries System Data 
 

 Incrementing # - Control number / Counters 
 

 Array – Structured Merged Data 
 
 
 
 
 

NOTE: Not all object types support all data sources; see specific object types to confirm. 
  



Data Sources 

 102 

 

5.1 Merge Data 
 

Merge Data are fields retrieved from an iSeries file and then ‘merged’ into a label.  
Barcode400 can use either Physical files (PF), Logical files (LF) or DDS Source files (DS).  
The data contained or passed within these fields can be placed on a format as text, bar 
codes, graphics, stored paragraphs and incrementing numbers. 
 

Merge files structures must be retrieved into the Barcode400 software prior to placing 
fields on a label format.  
 
 
 

NOTE: DDS and Data Files are never updated by Barcode400. 

 

 

 

Adding a Merge Field 
 

Click the                    button from the object's Properties DialogBox. 
  
 

NOTE:  The first time a merge field is placed on a label, the software will list available files (Data 
Descriptions).  If the desired file is not in the list, see Retrieve Merge File. 

 
 

 

 
 
 
Click on the desired field, enter your changes then click OK. 
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The Field Editor options will appear. 
 
 

 
 
 
 

The following field editing options are available. 
 

 Zero Suppress will convert any leading zeros in a field to blanks. 
 (Ex. M¦01<Z> when Field 1 = ‘00001’ will print as ‘      1’) 
 

 Remove Leading Spaces will cause all leading (left hand) spaces to be 
removed.  The data will be left justified. 

 (Ex. M¦01<R> when Field 1 = ‘    John Doe’ will print as ‘John Doe’) 
 

 Maintain Field Length will retain any leading or trailing spaces with the field. 
 (Ex. M¦01<M> when Field 1 = ‘Joe     ’ will print as ‘Joe     ’) 

 

 Show Decimal Point will add a numeric decimal point. Field must be defined in 
the file or program with decimal positions. 

 (Ex. M¦01<D> when Field 1 = ‘101.1’ will print as ‘101.1’ as opposed to ‘1011’) 
 

 SubString allows for portions of the field to be used.  Start Position indicates 
the byte within the field to start and Number of Characters is the number of 
bytes to include beginning with the Start Position. 

 (Ex. M¦01<?001,005?> when Merge Field 1 = ‘Steel Coils’ will print as ‘Steel’) 
 
 

These Field Options can be used in any combination and applied to each merge field to 
meet the user’s needs.  
 
Select the desired option(s). Click OK. 
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The DATA LINE will display the selected field prefaced by M¦ indicating a field (Ex: M¦01) 
was selected from the file. 
 
 

 

 
 
 
 

 
Click OK and place the object on the label format. 
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Sample Data 
 

Barcode400 does NOT use active IBMi file data on the format design, but rather a sample 
record is created when the DDS is first retrieved into the software. 
 

 
 
 
Click Get Sample Record. 
 

 
 
 
Select a File Record to function as your Sample Data. This will not affect the actual file. 
 
 

NOTE: If the file does NOT contain any records, Barcode400 will auto-fill the Sample Data Record 
or it can be edited manually. 

 
 

Click Record to Sample Data to continue. 
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The selected record will now populate the Sample Data Record. 
 

 
 
 
Barcode400 also allows you to the Edit Sample Data record. This will NOT affect your 
actual file data. Just check the Edit Sample Data box and make any needed changes. 
 
Click OK to Update. 
 
 
 

NOTE: The same Sample Data Record will be used for any format using the same Merge File. Any 
user using that Merge File on a format can edit its Sample Data Record. 
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Merge Directory 
 

To display the current list of available Data Descriptions, you must have either an existing 
label or a new label open in Edit Mode. Click Data in the Menubar, then Select Data 
Source. The Data Descriptions will appear. 
 
 

 
 

 
 

 

Retrieve Merge File 
 

Retrieving a Merge File makes a file available to be used with all label formats.  The DDS 
needs to be retrieved only once, unless the file definition is changed. If the file definition 
is changed on the iSeries, it will be necessary to refresh the File. 
 
 

Click Data, Select Data Source. The Data Description directory will appear. 
 

 
 
 
 

Click Add, Add Data Description to List.  
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The Data Description Details will appear. 
 

 
 

Browse the iSeries directory and select the desired iSeries library. In the example, the 
ACMELBL library was selected. The available files contained in the library are displayed. 
 
 

Select desired physical file, logical file, or DDS source file. In the example, the 
INVOICEARY file was selected. The Record Format(s) for this file will display.  
 
 

Select the Record Format. In the example above, INVOICEAYR was selected under the 
INVOICEARY file. 
 
 

The fields contained within the file will be displayed. 
 

 
 
 

If the file is keyed (indexed), a Descriptive field must be selected. Keys are displayed 
under the Key column.  
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Select 1 field to be the Descriptive field by clicking the check box next to the field name. 
Any Key Field (K1, etc.) cannot be the Descriptive field.   
 

 
 
 

In the example, CUSTNUM was selected to be the Descriptive field. 
 
 

NOTE: The Descriptive field is only used when printing from Option 1 (Create/Edit) or 2 (Print) 
within the Barcode400 software on the iSeries. 

 
 

Click Add This Definition to List to complete the function. 
 
 

QUICK TROUBLESHOOTING – If you receive an error, the DDS may exceed Barcode400 requirements. 
It must contain no more than 99 fields, 8 key fields, and a unique record format name.  

 

 

Update Data Description 
 

If a Merge File has recently been moved or changed, it will be necessary to update or 
refresh the Data Description.  
 

From the Merge Directory, right-click the Data Description. The menu options will appear. 
 

 
 

Select Update This Data Definition. The iSeries will confirm the Data Description’s 
location and updates the description before returning to the directory. 
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Remove a Data Description 
  

If a Merge File is no longer needed, it can be removed from the Merge Directory.  
 

From the Merge Directory, right click on the Merge File. Click Remove This Data Definition 
from List. 
 
Or click on the Mergefile, Edit then Remove DDS. 
 
 
 

WARNING: Removing the Data Description may affect existing labels. Confirm that formats DO NOT 
use this DDS before deleting it. 

 
 

 

View the Data Description 
 
To view the details of a Data Description, right-click on the Data Description. Now, click 
View this Data Description. 
 
Or click on the Mergefile, Edit then View DDS. 
 
 

The details of the Merge will display, including field name, description, length and type. 
 

 
 

Click OK or Cancel to exit. 
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5.2 Incrementing Numbers 
 

An incrementing number is a variable configured in the software that produces serialized values.  
This could be used if the label required a box count.  Incrementing numbers can be placed on a 
label format as text or bar code (Not available for two-dimensional barcodes). 
 

An incrementing number must first be created. See Create Incrementing Number.   
 

When using an incrementing number on the label format, the user, at print time, will be 
prompted for HOW MANY SETS and THE NUMBER OF LABELS PER SET to print.  

 

 

Incrementing within a set of labels - C¦ 
 
Example: Print TWO SETS of labels with THREE LABELS PERSET.  A total of 6 labels will 
print. In this example, the number counts up, and hen begins again on the next set.  
 

 

 
 

 

 

 

 

                                                                 SET ONE                                                                   SET TWO 

 

 

 

 

 

 

 

 
 
Incrementing after each set of labels - R¦ 
 
Example: Print THREE SETS of labels with TWO LABELS PERSET.  A total of 6 labels will 
print. In this example, the number repeats, then increments for the next set.  
 
 

 
 

 

 

                                         SET ONE                                                  SET TWO                  SET THREE 

 

 

 

 

 

 

 

 

 

                                                                                                                                

 

1 of  3 

 

2 of  3 

 

3 of  3 

 

1 of  3 

 

2 of  3 

 

3 of  3 

 

1 of  3 

 

1 of  3 

 

2 of  3 

 

2 of  3 

 

2 of  3 

 

2 of  3 
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Add an Incrementing# 
 
To use an incrementing number, add or edit a Text Object or Barcode Object. 
 
Click the                   button from the object's Properties DialogBox. 
 

 

 
 

Select the desired incrementing number. 
 

 
 
 

Select Field Editing Options, if desired. 
 

The following field editing options are available. 
 

 Zero Suppress will convert any leading zeros from a numeric field to blanks. 
 (Ex. M¦01<Z> when Field 1 = ‘00001’ will print as ‘      1’) 
 

 Remove Leading Spaces will cause all leading (left hand) spaces to be 
removed.  The data will be left justified. 

 (Ex. M¦01<R> when Field 1 = ‘    1’ will print as ‘1’) 
 

 Maintain Field Length will retain any leading or trailing spaces with the field. 
 

 Select increment within a set of labels (see preceding explanation of C¦). 
 

 Select increment after each set of labels (see preceding explanation of R¦).  
 

 
Click OK to continue. 
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The Incrementing Number now appears in the Data Line of the Text or Barcode object. 
 

 

 
 
 

The DATA LINE will display the selected incrementing number prefaced by a C¦ 
(increment within a set of labels) or R¦ (increment after each set of labels). 
 
 

 
NOTE:  Incrementing numbers CANNOT share the Data Line with any other object or value. Use the 
prefix and suffix fields for additional constants or variables. 

 
 
Click OK and place data on label format. 
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Create Incrementing Number 
 

In the Menubar, click Tools in the Menubar> Work with Incrementing Numbers... 
 

 
 
 

Click Edit > Create Incrementing Number 
 

 
 
 

Define the Incrementing Number properties. 
 

 Name – Can be up to 10 characters. 

 Description – Describes function of the incrementing number. Not mandatory. 

 Starting # - This will be the NEXT value used when printing. 

 Number of Digits - The number of places.  For example, a value of 3 would allow the 
number to increment to a maximum of 999 before restarting. 

 Increment Amount – How much the number will count up or down each time. 

 + or - determines if the number increments or decrements (count up or down). 

 Reset Starting# After Each Set – If the checked, the number will reset the Starting# 
value to 1 when a new set of labels is printed. 

 

 

NOTE: The reset value is recommended when printed a set of labels that count product (1 of 6, 2 
of 6, etc.). If the label will produce a continuous serial number, best to leave it unchecked. 

 
  

Click OK. 
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Editing Incrementing#’s 
 

From the Incrementing Number directory, select the incrementing number then select the 
File menu or right-click for options. 
 

 
 

 
Click Edit Selected Number. The Create Incrementing Number screen will display. 
 

 
 

Make the needed changes, and then click OK. 
 

 

Delete Incrementing#’s 
 

At any time, you can delete an incrementing number. 
 

 
 
 

From the Incrementing Number directory, select the incrementing number then select the 
File menu or right-click for options. 
 
Click Delete Selected Number. 
 
Click OK to confirm and delete.
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5.3 System Date/Time 
 

System data refers to time and date values maintained by the iSeries. The current value 
will appear on the label at the time the labels are generated. 
 

 

Add a System Date/Time Field 
 
 

Add or Edit a text or barcode object. Click the           button in the objects 
Properties Dialogbox. 
 

 
 
 

Click on the desired keyword (formatted data). Then, click OK.  
 
 

The DATA LINE will display the selected keyword prefaced by an S¦ indicating System 
Data. In this example, month/day/century has been selected. 
 

 

 
 
 

Click OK and place data on label format. 
 
 

NOTE: Current PC date/time values will appear in GUI, but iSeries date/time values will be used 
when printing. This is not the same as a Real Time feature on the printer.   
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5.4 Prompt Fields 
 

Prompt fields are created so the operator, at print time, will be prompted for data to be 
printed on the label. Prompt Fields are unique to each format that uses them. 
 
Prompt fields are only available if printing is executed from the Barcode400 label printing 
functions within the green screen designer or the Interactive Label Printing feature. 
 
 
 

NOTE: Barcode400 does NOT condition the data from these prompts. 
 

  

 

Add a Prompted Field 
 

Click the                    button in the object's Properties DialogBox. 
 
 

 
 

Select the desired prompt. If there are no prompts available or if a new prompt is 
needed, see Create a Prompted Field on the following page. 
 
Click OK. 
 
 

 

 
 

The DATA LINE will display the selected prompt prefaced by F¦ indicating that prompt 
number 01 was selected. 
 
 

Click OK and place the field on the label format. 
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Create a Prompted Field 
 

If a desired prompt does not appear, Click Add.  
>Add New Prompt and Sample Data 

 

 

 
 
 

Enter desired prompt as it will appear and sample data to appear on screen. 
 

Click Add. The new prompt will appear in the Prompted Data Fields. 
 
 

 

Edit a Prompted Field 
 

Click on the Data Menu.  
>Select Setup Prompts for Prompted Data 

 

 
 

Right-click on the Prompt, then select Edit. 
 
  

 

Delete a Prompted Field 
 

If a prompt needs to be removed, click on the Data Menu. 
>Select Setup Prompts for Prompted Data 

 

Right-click on the Prompt, then select Delete. 
 
 
 

WARNING! Any object using this prompt must be removed or edited before printing. 
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5.5 Arrays 
 

An Array is another form of merged data, but they are retrieved by byte position not by 
field number. Data from an array can be used in text, bar codes, graphics, stored 
paragraphs and incrementing numbers. 
 
Arrays are retrieved from an iSeries file, and then merged into a label.  Barcode400 refers 
to these files as Merge Files; either Physical (PF), Logical (LF) or DDS Source files (DS).   
 

The merge file structures used must be retrieved into the Barcode400 software prior to 
placing an array on a label format. 
 

 

 

Add an Array 
 

Click the                      button in the object's Properties DialogBox.  
 
 
The Data Descriptions window will display. 
 

 
 
Select the file from the Data Description list and click OK.  
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The Array Setup window appears. 
 

 

 
 

 

 

Unlike Merge Data, which pulls in specific fields, Arrays allow data from any part of the 
file record to be used. They can be used to combine multiple fields into one object. 
 
 
In this screen, fill in the four-digit Starting Position of the first byte to read.  
 
Select the Element Length by entering the three-digit value of how many characters to 
read from the record. 
 
 
The Element Count is how times the Element Length is read; each count on its own line.  
 
 
Decimal Places determine the number of decimals to display if fields in the array are 
numeric. All decimal fields will display the same number of decimal places. 
 
 
Line Spacing is how many dots (in 1/100th of inches) is the next line below the last. 
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Once the values are populated, click OK. The Array appears in the Data Field. 
 

 
 
Notice the A¦ reference. 
 

A¦<0007,025,003,01?> 
 
 
 
 
 
Click OK to continue. The Abc icon will appear on the workspace.  
 

 
 
Position the cursor, then left-click to place the Array object on the label. 
  

Starting Position Line Spacing 

Array  Length Line Count 
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The Array item now appears on the screen. 
 

 
 
 
Notice this single array object is creates three lines of data; each line is 25 bytes long and 
is retrieved starting at position 0007 from the merge file record.  
 
 

Merge Directory 
 

To display the current list of available Data Descriptions, you must have either an existing 
label or a new label open in Edit Mode. Click Data in the Menubar, and then Select Data 
Source. The Data Descriptions will appear. 
 
 

 
 
 

To Retrieve, Update, or Remove a DDS, see Chapter 5.1 (Merge Data) 
  



Menu Bar 

 123 

6. Menu Bar 
 

At the top of the work screen is the Menu Bar. This bar may be locked at the top of the 
Window or it can be dragged out to form a pop-up menu. 
 

 
 
 
 

6.1 File Menu 
 

This menu includes functions relating to the label format; Create, Open, Close, Save 
Options as well as Format Properties and Test Print. Also, the user can Exit Barcode400. 
 

 
 

 

Create New Label Format    
 

Opens a new blank label format. Initial settings are based on the Application Values. 
 
 

Open Existing Label Format 
 

Opens the Label Format Directory, in order to edit an existing format. 
 
 

Close Current Label Format 
 

Closes out the label format being actively edited. The user will be prompted to save the 
format before exiting. 
 
 

Save Label Format   
 

Saves the currently active format to the iSeries, but does not close the format out. 
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Save Label Format As    
 

Prompts for a new Label Name to save the currently active format to the iSeries, does not 
close the format out. 
 
 
 

Label Format Properties 
 

Displays the format’s current settings.  
 

 
 
 

Test Print   
 

Print a copy of the currently active label, using Sample Data. 
 
 
 

Create Image of Label 
 

This option exports the label format as an image file (.bmp, .jpg, .gif, .png, .tif or .pcx). 
The image file is then saved to a selected PC hard drive or a network folder. 
 
 
Exit Barcode400 
 

Closes the Barcode400 application. If a format is currently active, the user will be 
prompted to save their work. 
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6.2 Edit Menu 
 

This menu functions feature add or manipulating objects on the label; Undo, Redo, Add, 
Cut, Copy, Paste, Delete and Select All. 
 

 
 

Undo 
 

Any recent action can be retracted by selecting this option. The Undo also restores 
recently deleted objects or removes unintentionally created objects.  
 
 

Redo   
 

This function effectively reverses an Undo – restoring a label design’s state before the 
Undo was performed. Any recent action can be retracted by selecting this option.  
 

 
Add New Label Object 
 
Any standard label element (barcode, text, line, rectangle, graphic or stored paragraphs) 
can be added from this option as opposed to using the buttons on the Toolbar.  
 
 

Cut  
 
Removes highlighted object(s) from the label design, but stores them in the Windows 
clipboard. 
 
 

Copy  
 
Creates a duplicate of any highlighted object(s) and stores it in the Windows clipboard. 
 
 

Paste  
 
Any object(s) in the Windows clipboard from a Cut or Copy will be placed on the label. 
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Delete  
 
Permanently removes any highlighted object(s) from the label.  
 
 
 

WARNING: Only Undo can restore a deleted object. 
 

 
 

 

Select All 
 

Highlights all objects on the label at once. All objects can then be Cut, Copied, Deleted 
or dragged to a new location.  
 
 

 
 

6.3 View Menu 
 

This menu functions allow the user to manipulate how format designs are displayed on the 
work screen; including Zoom, Grid, Rotate, and Properties. 
 

 
 
 

Zoom 
 

The label format display can be enlarged for more accurate object placement or reduced 
to view the overall design. Magnification ranges from 50% - 500%. Or set to Fit to Window. 
 
 

 

Zoom Bar 

Click the Zoom In  button to magnify the label format or click Zoom Out  button 
to de-magnify the view of the label format.  
 

or 
 

Click on the Zoom magnification  button to select a specific magnification. 
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Grid 
 

A grid work of dots or lines can be overlaid on the format for easier object alignment. 

There is also a Grid  button on the toolbar.   
 
The Grid button is a toggle.  If the grid is not visible, clicking Grid will make the grid 
appear.  If the grid is visible, clicking the Grid button will remove the grid from view.  
 

To change Grid Appearance, see below. 
 

 

Click the Grid Options drop down  button to display grid options. 
 
 
 

Grid Menu Options 
 
 
 

Show Grid 
 

 If the grid is not visible, clicking Show Grid will make the grid visible.   

 If the grid is visible, clicking Show Grid will remove the grid from view. 
 
 
Snap To Grid 
 

 Always On - Will cause any data being placed on a label format to be "snapped" 
into place.  The snap-to increments are based on settings in the Grid Size option. 

 Snap Only - When Grid is Visible will enable the snap-to grid function, but only 
when Show Grid is on. 

 
 
Grid Type 
 

 Dots - Displays the grid in dots spaced at increments specified in the Grid Size. 

 Lines - Displays the grid in lines spaced at increments specified in the Grid Size. 
 
 
Grid Size  
 

 Select increments used for the snap to feature.  Increments range from .075 
inches to 1 inch. 

 
 
Ruler Increment 
 

 Affects how the ruler lines are displayed in the design screen.  Each inch on the 
ruler can be adjusted to 1/10 inch, 1/8 inch, or 1/4 inch. 
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Rotate Label Format 
 

This option allows the entire format design to be turned in 90 degree increments. All 
objects on the label will be turned and repositioned. 
 
 

Click the Label Rotate    button in the top, left corner where the rulers intersect. 
 
 
 

NOTE: Graphics do not rotate. 
 
 
 

6.4 Tool Menu 
 
This menu allows direct access to object directories. 
 

 
 

Work With Graphics 
 
This option will access the Graphic Directory. 
 

 
 

The user can right-click on an image to Copy, Rename or Delete logos from the Directory 

or click Add  to transfer a new image to the iSeries. Also see Graphics. 
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Work With Stored Paragraphs 
 
This option will access the Paragraph Directory. 
 

 
 
The user can right-click on a Stored Paragraph to Copy, Rename or Delete paragraphs 

from the Directory or click Add  to create a new Stored Paragraph. Also see Stored 
Paragraphs. 
 
 
 
 
 
 

Work With Incrementing Numbers 
 

Click this option to access the Incrementing Numbers Directory. 
 

 
 
 

The user can right-click on an Incrementing Number to Edit, Delete, or Create control 
numbers. Also see Incrementing Numbers. 
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Work With Overlays 
 
This option will access the Overlay Directory. 
 

 
 

 
The user can right-click on an Overlay to Copy, Rename or Delete. Also see Overlays.  
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6.5 Options Menu 
 
These additional functions affect the appearance and global function of Barcode400. 
 

 
 

 

 
Language 
 
Barcode400 defaults to English. There are additional options for Spanish, French, German, 
and Italian.  
 

 
 
 

 

*As of Version 4.0, only English is supported. 
 
 
 

Toolbar Appearance 
 

Barcode400 has several options to set the Toolbar and Design screen display. 
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Change Server 

 

Barcode400 allows the user to connect to multiple iSeries, but only connects to one CPU 
at a time. By selecting this option, the user can indicate which iSeries to connect to the 
next time the software starts. 
 

 
 
 

NOTE: You must close and restart the software to connect to the new server. 
 

 

 

Barcode400 Global Values 
 

This option accesses various default and connection settings. Also see Application Values. 
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6.6 Help Menu 
 

The Help Menu provides additional resources to the user, explaining the software’s 
functionality and providing contact options to T.L. Ashford. 
 

 
 
 

Help Table of Contents 
 
 

Click on Help T.O.C. (Table of Contents) to view the list of help subjects. 
 

 
 

 
 

Or Index for a complete topic list. You can also go the Search tab to find a specific issue. 
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Technical Support 
 

T.L. Ashford and Associates offers easy to access technical support to Barcode400 users. 
Clicking on this option opens this window – 
 

 
 
 
Support lines are open 8a-5p EST Monday through Friday. Click the web link to our website 
for the latest new and software updates. Email your support representative. Or open a 
Live Chat (below) with a T.L. Ashford support representative, during support line hours. 
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Videos – Getting Started 
 

New users to Barcode400 might wish to view our series of introductory videos by clicking 
this option. The video player can be positioned on screen and scaled to allow you to work 
along with the instructions. 
 

 
 
 

Videos – Training Library 
 

Numerous videos are available for viewing from T.L. Ashford’s website for more in-depth 
training and instruction on all aspects of Barcode400.  
 

 
 
Just use your Download Access sign-in. If you do not yet have an access code, you can 
register as well. 
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About 
 

This option will display your currently installed version of Barcode400. 
 

 
 
Also, links to our support email, website and Live Chat can be directly accessed. 
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7. Additional Functions 
 

7.1 Video Help 
 

On various pop-ups or property screens, you may see a link to Video Help (See below) 
 

 
 

 

 

Clicking the link(s) will produce a Video Help pop-up specific to the object or topic. 
 

 
 
The Video Help can be viewed, paused, rewound, or fast-forwarded. There is a volume 
control as well. At any point, the Video Help can be closed by clicking the  

Video Help 
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7.2 Label Setup 
 

The Label Setup menu allows users to define the label format’s target printer, dimensions 
and desired media options. 
 
 

Change Target Printer  
 

Target Printer is the printer make and model for which a label format is being designed. 
The Default Target Printer is specified under Application Values on the SignOn screen. 
 

 
 

Right-click in the Design area on the label format > Select Show Properties DialogBox. 
 
 

 
 
 

Select desired printer Manufacturer/Model. Click OK. 
 
 
 

 
NOTE: Changing the Target Printer can change how the existing elements on your label appear, 
including graphics and barcodes. 
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Change Printer Options 
 

Right-click in the Design area > Select Show Properties DialogBox.  
 
The Label Settings will appear. 
 

 
 

 

To access the Printer Options, click on the Target Printer Options button.  
 

 
 

The Printer Options are unique to each printer type. But, most common will be Print 
Speed, Darkness, Dispensing Method and Font options. Make any needed changes.  
 

Click OK.  
 

 
NOTE: Options displayed are at their Default, not the current settings.  
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Change Label Size 
 

Label Size refers to the format’s dimensions in relation to the media on which it will be 
printed.  Barcode400 determines height and width by the orientation the paper is loaded 
into the printer, not how the label is applied. Label Size defaults to 4” wide by 6” high. 
 

 
Right-click in the Design area> Select Show Properties DialogBox.  
 
The Label Settings will appear. 
 

 
 
 

On the General tab, under Label, enter the format Height and/or Width. Click OK. 
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8. Test Printing 
 

Label formats can be test printed from the designer to iSeries output queues or locally 
to printers connected to the PC. 
 
 

NOTE: Formats using Merge Data or Prompted Data will test print using Sample Data as it appears 
in the label designer. The Graphical Designer does NOT access file data. 

 

 

Click the Test Print button  in the tool bar. 
 

 
 

The Select Printer Window Appears. 
 
 
 

Choose from iSeries or Windows printers. Select the desired printer. 
 

 
NOTE: If you do NOT see the printer queue in the iSeries list, it must be added via Barcode400’s 
main menu on the IBMi, Option 9 (Utility Menu - Configure Printers). 

 
 
 
 

Select the number of copies to print. 
 

Click OK to print. 
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9. Programming & Integration 
 

Labels designed within the Barcode400 designer can be executed from existing iSeries 
applications in order to completely automate label printing.  Once the proper code has 
been placed within the application program and the program is compiled, the label 
format may be changed without recompiling the program. 
 

 
 
 

CL – LBLBATCH / LBLBATCHC 
 

Batch processing means reading a data file containing one or more records and printing a 
label(s) for each record.  Label printing can be initiated within a CL program, from an 
IBMi command line or from the Barcode400 menus on the IBMi. 
 
 
 

RPG & COBOL 
 

Barcode400 can be called from within an existing RPG or COBOL application.  Once proper 
code has been placed within the program and compiled, the label format may be changed 
as often as necessary without recompiling the program. 
 
 
 
 

LBLPRNT 
 

The LBLPRNT command allows a user to quickly print a label without having to go to the 
Barcode400 main menu on the iSeries. 
 
 
 
 

Complete programming details and sample programs are available in the Barcode400 
Users’ Guide, Chapter 2. 
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Appendix A: Barcode Code Symbologies 
 

Popular 1-D Barcode Symbologies 
 

Since 1949, when the bar code was first conceived for use in automating grocery store checkouts 
and inventories, dozens of symbologies have been developed for general and specialty use. 
However, a handful of types have become more widely used among retailers, industry groups, and 
shipping companies. The most common are detailed below and are supported in Barcode400. 
 
 
 
 
 

Codabar (iSeries versions list this as type D) 
 
As one of the symbologies competing to be the first grocery industry standard, Codabar was beat out by the 
U.P.C. in 1973. However, it was soon adopted by the blood banking industry for marking bags. Also, it was 
the first shipping symbology used by Federal Express. 
 

Codabar is a numeric-only symbology with no check digit, a fixed ratio and a limit of 100 bytes. 
 
 
 
 

Code39 
 

Code 39, or Code 3 of 9, was the first standardized barcode for manufacturing and shipping. The symbol’s 
high ratio and density make it suitable for printing on large cartons and can easily be read by long-range 
scanners. Developed in 1982 by Intermec, Code 39 is still widely used in part identification and shipping. 
 

Code 39 is an alphanumeric symbology (upper-case only) with a limit of 40 bytes and a variable ratio.  
 
 Variations 
  

Code 39, 1:3 Ratio (iSeries versions list this as type A) 
The BNA type represents the most common version of Code 39. The high narrow-to-wide ratio of 
bars and spaces gives the symbol a high readability and durability. 

 
Code 39, 1:2 Ratio (iSeries versions list this as type Y) 
The lower ratio increases density, allowing the same data to use less space, but may sacrifice 
readability. 

 
Code 39, 1:2.5 Ratio (iSeries versions list this as type @) 
This variation is the middle ground between the high and low ratio symbologies. 

 
Code 39, 1:3 Ratio w/ Mod43 Check Digit (iSeries versions list this as type 3) 
This variation is a standard 1:3 ratio barcode (BNA), but a Modulus 43 check digit is added to 
confirm data content. The Health Industry Business Communications Council (HIBCC) requires this 
variation to produce their industry standard labels. 

 
 
 
 

Code93 (iSeries versions list this as type 2) 
 

Originally, Code 93 was developed by Intermec to compete against Code 128 in 1982. Using the same 
character set as Code 39, it could produce a more efficient alphanumeric symbol than Code 128. However, 
Code 128’s double-density encoding mode could produce more efficient numeric-only symbols.  
 

Code 93 is an alphanumeric symbology (upper-case only) with a limit of 100 bytes and a fixed ratio.  
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Code 128 
 
Developed by Computer Identics in 1981 to produce compact alphanumeric barcodes, Code 128 can encode 
the complete 128 ASCII character set. To best utilize its double-density capability (two values into one 
coded character), Code 128 offers three choices of character sets (Subsets). Each option allows for 
improved data flexibility or maximum efficiency. 
 
 Subsets 
 
 Code 128, Subset A (iSeries versions list this as type 0) 

Code 128, Subset A converts pairs of values into single hex-decimal values. While this conserves 
space, some barcode readers may not decode the barcode value back into the original two values. 

 
Code 128, Subset B (iSeries versions list this as type Z) 
Code 128, Subset B encodes each character as a single value. This makes Subset B the widest of the 
three variations, but it is also the most flexible, allowing for the encoding of numeric values as well 
as upper and lower-case alpha characters and punctuation marks. 

 
Code 128, Subset C (iSeries versions list this as type 1) 
Code 128, Subset C converts pairs of digits into single values. This noticeably conserves space, 
however the symbology is limited to evenly paired numeric values. Most printers will either drop the 
odd digit or add a zero as a prefix to meet this requirement. 

 
 Variations 
 
 Code 128, Subset C + FNC1 Prefix (iSeries versions list this as type f) 

This variant of Code 128, Subset C adds an unprintable ASCII value (Function 1) before the data 
content. This conforms to the GS-1 requirements for barcodes using an Application Identifier. The 
GS-1 or UCC/EAN 128 uses the FNC1 to indicate that an identifier is being used. When scanned, an 
application can determine the function of the barcode after determining the value of the AI. 

(Example: FNC142012345 = 420 (Domestic Postal AI) + 12345 (Postal Code)) 
 

Code 128, Subset C + FNC1 Prefix + Modulus 10 Check Digit  (iSeries versions list this as type W) 
This variant of Code 128, Subset C is a special function barcode used for creating the GS-1 or 
UCC/EAN Serial Shipping Container Code or SSCC-18. This barcode automatically adds a calculated 
check digit to the original 19 digits passed to it. 

 
 
 

 

EAN –13 (European Article Numbering) (iSeries versions list this as type T) 

 
Founded on the principles of U.P.C., non-U.S. groups adopted the International Article Numbering system in 
1976. This included the addition of another digit to the U.P.C.’s 12-digit symbol, to allow for an 
international number system. Like the UPC, the first 6-8 bytes of the GTIN-13 encoded data identify the 
manufacturer of a product, and the remaining 4-6 bytes determine the individual product. 
 
 Variation 
 
 GTIN-8 / EAN-8 (iSeries versions list this as type U) 
 

Like UPC-E, this short-form is used when an EAN-13 would be too big for the product being labeled.  
EAN-8 uses zero suppression to truncate the vendor ID and product number, the same as UPC-E. 
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Interleaved 2 of 5 
 
Interleaved 2/5 was developed for carton transportation and storage. The symbol’s high ratio and low 
density make it suitable for printing on large containers and cartons and can easily be read by long-range 
scanners. Developed by Intermec, Interleaved 2 of 5 is still widely used in carton storage and warehousing. 
 
 Variations 
 

Interleaved 2/5, 1:3 Ratio (iSeries versions list this as type K) 
This type represents the most common Interleaved 2/5. The high narrow-to-wide ratio of bars and 
spaces gives the symbol high readability and durability. This variant is used for most carton labels. 
It can encode from 2 to 40 characters in even-numbered sets. 

 
Interleaved 2/5, 2:5 Ratio (iSeries versions list this as type i) 
This type uses a lower ratio to increase density, allowing for the same data to use less space at the 
sacrifice of some readability and durability. 

 
Interleaved 2/5, 2:5 Ratio w/ Mod10 Check Digit (iSeries versions list this as type 9) 
This variation is the same as BNK, with the exception that it is searching for 13 digits for the SCC-14 
(a.k.a. GTIN, UCC-14 or UPC Container barcode). The software will automatically calculate the 14th 
position check digit and add it to the end of the code. 
 
Interleaved 2/5, 1:3 Ratio (iSeries versions list this as type a) 
This variant uses the higher ratio of the BNK, with the check digit function of the BN9. 

 
 
 

 
UPC – Universal Product Code / GTIN-12 (iSeries versions list this as type P) 

 
Adopted by the U.S. Grocery Industry in 1973, the UPC is still one of the most commonly seen bar code 
symbols. GS1, formerly the Uniform Code Council (U.C.C.), oversees the assigning of manufacturer ID 
numbers to its members, who in turn, assign unique numbers to their products. The combined values are 
scanned at point of sale registers. 
  
 Variation 
 

UPC-E (iSeries versions list this as type R) 
For products too small for a full-sized UPC-A, a zero-suppressed version is available that truncates 
the same data into 8 bytes. 
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Two-Dimensional Barcode Symbologies 
 

Allowing up to 2,000 characters in a single symbol, the next generation of barcodes increased 
capacity and flexibility while reducing symbol size. 
 
 

 
Data Matrix  (iSeries versions list this as type Q) 

 
Able to be crafted directly into a component part or material, in addition to traditional 
printing, Denso’s Data Matrix can engrave a few bytes on a computer chip or print over 
2,000 characters. 

 
 
 

Maxicode  (iSeries versions list this as type X) 
 

Developed by UPS (United Parcel Service) for high-speed automated package sorting, 
Maxicode can encode up to 100 characters in a 1-inch square “bulls-eye” symbol. 

 
Maxicode has a rigid structure that cannot be deviated from, particularly the first 16 
characters (Country, Service and Postal Code) 

 
 
 

PDF-417 (iSeries versions list this as type E) 
 

To meet the need for detailed information, Symbol’s Portable Data File (PDF) can encode 
over 1,000 bytes, including graphics, in a highly secure matrix symbology. 

 
PDF-417’s ability to store a large amount of information has allowed for organizations like 
the auto industry to create a single symbol to replace numerous one dimensional barcodes 
on their label. 

 
 
 

QR Code (iSeries versions list this as type q) 
 

Originally created by Denso for the automotive industry, the easy-to-scan QR is now popular 
in marketing and advertising for scanning from mobile internet devices. 

  



Appendix 

 149 

 
Appendix B: Printers Supported 
 

TL Ashford is continuously adding printers to the list of printers supported. If you cannot find the 
specific printer Manufacturer or Model in our list, please contact us. We will do our very best to 
accommodate the requirements. 
 
 
Analog Technologies  2020, 8220, 8045E, 8030, Laser, Codajet Print Server 

Argox   A50, A150, A200, OS-2030, OS-2040, OS-213, OS-214, OS-314, R-400, R-600, X-1000,  
X-2000, X-3000. G-6000 

Avery-Soabar   SPX360, SPX362  

Avery-Dennison  TTX 450, TTX 650, TTX 950, TTX 1050, TDI Tag Printer, TTX 720 Print & Apply, 6404, 
6405, 6405-RFID, 6408, 8045E 

CIE America   250, 300, 400, 600, 800 with QMS 

Citizen    CLP-521, CLP-621, CLP-1001, CLP-2001, CLP-6001/6002, CLP-7001/7002, CLP-7201,  
   CLP-7401, CLP-8301, CL-S420, CL-S521, CL-S621, CL-S631, CL-S700 

C-Itoh    CT40, CT60, S4, T4   

Data South   Barcode 300 TX, Performax 600 TX 

DataMax / O’Neil A-Class, E-Class, DMX400, DMX430, DMX600, DMX800, H-Class, I-Class, M-Class,  
   S-Class, W-Class, MP Compact, Ovation, Prodigy Max, RL4, Titan 

Decision Data (Magnum Graphics) 

Eltron   Eclipse, HT146, LP2122, LP2142, LP2622, LP2642, LP2742, LP2844, LP2443 (ORION), 
P2242, STRATUS, TLP2046, TLP2344, TLP2642, TLP2742, TLP2746. TLP2844, TLP2824  

Eltron/RJS   QB440, QB450, 240, 260, 285 with CL+  

Esselte    Meto Bandit, EM450, V40 (DPL),V65, V85 

Facit   MP-4, MP-6, Continuous Forms Laser 

Fargo   Allegro, Allegro 2, Prodigy, Prodigy Plus 

Genicom   3812, 3842, 4492, 4592, 4812, 4842, 4912, 4942, 6241, 6241LL, 6321, 6322DT, 6341, 
6342, 6342DT, 6342H, 6441, 6442, 6451, 6451V, 6481 

Genesis  9300 Print & Apply, 9500 Print & Apply  

Godex  RT Series, DA Series 

Hewlitt-Packard (HP) HP Laser (AFP Driver) 

IBI    Continuous Forms Laser with Code V 

IBM    4400-04, 4400-06, 4400-08, 5500-R40, 5500-R60, 5500-R80, 6700-04, 6700-06,  
   6700-08, 6400-6412 (Code V), 7516, 7517l 

Inducomp   N-454 

Intermec  3100, 3240, 3400a-e, 3440, 3600, 4000, 4100, 4400, 4420, 4440, 4630, 4830, 7421,  
  7422, 8710, PB50, PC41, PD41, PD42, PF2, PF4, PF4i, PF8, PL4, PM4i, PX4i, PX6i 

Mannesman Tally  645, 661, T6045, T6065, T6090, T6091, T6140, T6141 

Monarch  5170, 9411, 9412, 9413, 9414, 9416, 9445, 9446, 9474, 9490, 9800, 9805, 9813,  
  9820, 9825, 9830, 9835, 9840, 9850, 9854, 9855, 9860 
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Novexx   Tiger, Puma, Lion, Chess Series 

Paxar   520, 540 

Printek    4003, 4500, 4503, 8003 with Imager Plus 

Printronix  L150, L1016, L1024, L1524, T1006 (VGL), T2204 (SGL), T3306 (IPL, VGL, FGL), 4204,  
   P300, P600, P5000 Series, T5000 Series, T4M  

RJS    260, 285 (ZPL), 240, 260, 285 (CL+), QB440, QB450 

Sato   M8400, M8400 S, M8400 RV, RVe, 84PRO, M8460 RV, M8450, M8485, CG208, CG212, 
CG408, CG412, CL408, CL408e, CL608, CL608e, CL412, CL412e, CL612, CL612e, 
CT400, CT410, CX200, GL408, GL412, GL608, GL612, GT408, GT412, GT424, LM408, 
LM412, M10, MB400, S8408, S8412, S8424, XL400, XL410 

 
Soabar    TTX450, TTX 720 Pax 

Standard Register  PT560 

TEC    B-402, B-602, B-SX4, B-SX5, B-SX6, B-452, B-472, B-572, B-672, B-872 

Tharo    Apollo 3, Freedom, 112+  

Willet    2610/8 Print & Apply 

Zebra   A300, DA402, GC420, GK420, GX420d, GX420t, GX430t, QL320, QL420, PA400, 
PT400, P4T, RW420, R4M, R110XI (RFID), R170XI (RFID), S300, S400, S500, S600, 
Stripe, T220, T230, T300, T402, ZE500, Z4M, ZM400, Z4000, Z6M, ZM600, Z6000, 90, 
90A, 90XI (I, II, & III), 91, 92, 95, 105, 105S, 105SE, 105SL, 130, 110XI, 140, 140XI (I, 
II, III, & IV), 142, 160S, 160SE, 220XI (I, II, III, & IV), 170XI (I, II, III, & IV), 110PAX, 
170PAX, HT146, LP2824, LP2844, TLP2844, 2443, 2684, 2722, 2742, 2746 
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Appendix C: Troubleshooting  
 

Connection 
 
Attempting to start Barcode400 and receive the message “Cannot Connect to Server” or “Existing 
Connection was Forcibly Closed by Host”.  
 

1) Barcode400 uses the IP address of your iSeries CPU to connect. Confirm that the address in the 
Server Connections is the correct CPU Ethernet address and the correct box is checked. 

 

2) In Windows, users must have Administrator Authority to the Barcode400 folder (C:\Program 
Files\T.L. Ashford & Associates) or set the T.L. Ashford & Associates folder to Run As Admin. 

 

 

Design 
 

Text Fields 
 

1) If the desired font is not listed, confirm the label’s Target Printer is correct. Only the fonts for 
that printer type will be available. 

 

2) True Type fonts are available for many printer brands, but they must be installed on the printer 
first. If necessary, use our Font Download application. 

 

Barcode 
 

1) If the barcode displays a Red X after being placed on the label, this is a warning of a potential 
error based on the barcode’s type and data. Confirm that the type and amount of data being 
encoded meets the barcode’s requirements. Also, confirm any Sample Data for Variable fields. 

 

2) If data is missing from the barcode when scanned, confirm the barcode type vs. merge data. Some 
barcodes may not encode punctuation, lower-case letters, numeric values only or require a specific 
number of characters. 

 
Graphics 
 

1) Graphics must be transferred to the iSeries first to be able to be added to the format. 
 

2) Graphic must be transferred in the desired orientation. Graphics cannot be rotated on the label. 
 

3) If the logo prints too large or too small, be sure the label’s Target Printer type matches the 
Outque. Also, be sure to re-size the image if needed during the Logo Transfer. 

 

Merge Data 
 

1) The file should NOT contain more than 99 fields (except when using arrays) with no more than 8 
key fields, 9,999 total bytes and the record format should have a unique name. 
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Printing 
 

Not Printing 
 
Attempting to Test Print from Barcode400, no labels print or printer produces a blank. 
 

1) Confirm the printer is connected properly and the iSeries outque is Active with no error messages. 
 

2) Confirm that the printer is in the Printer Configuration Chart in the Barcode400 Utility Menu and 
defined as the correct printer type. 

 

3) Network or PC-connected printers should be using Host Print Transform on the outque or device. 
 

4) If printing from a Barcode400 print program, confirm the Printer File is being overridden to the 
correct printer device or outque (BCLBL132 for Intermec, BCLABELS for all others). 

 

 

Print Results Do Not Match Display 
 
Label prints, but does not match the GUI’s on-screen version. 
 

1) Confirm the printer’s model and resolution matches the Target Printer. (Ex. If the printer is a 203 
dpi Sato, be sure to use a 203 dpi type). This can also affect barcode and graphic dimensions. 

 

2) Confirm the Display Properties in Windows. If Windows is not set to 100% (96 dpi), the GUI may not 
display or print the label correctly to scale. 

 

3) If the label uses True Types fonts, they must be installed in the desired printer first, otherwise the 
printer will substitute a default font. See Download Fonts. 

 

 

Label Only Prints Spool Data 
 
Label prints, but the data is not formatted and only prints the literal spool content. 
 

1) Confirm printer model and type before printing. Also, confirm that any Barcode400 print program 
matches the printer model (Ex. Z4XI1024 for a Z140xi). Check Appendix A in the User Manual. 

 

2) Confirm the printer is not configured as a Line Printer or in Hex Dump/Diagnostics Mode. 
 

3) Confirm remote outque or iSeries device is using Host Print Transform to convert spool files. 
 

 

 

 
If you experience any issues connecting, designing or printing, contact your T.L. Ashford & Associates 
Technical Support Representative. 
 
 

Phone:   (800)-541-4893 
Fax:   (859) 291-1804 
Email:  tech@tlashford.com  
Live Chat:  www.tlashford.com 

 
  

mailto:tech@tlashford.com
http://www.tlashford.com/
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